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Preface 

The user manual of this serial server has introduced this device: 

 Product features 

 Network management method 

 Network management relative principle overview 

Readers 

This manual mainly suits for engineers as follows: 

 Network administrator responsible for network configuration and maintenance 

 On-site technical support and maintenance staff 

 Network Engineer 

Text Format Convention 

Format Description 

“” Words with “” represent the interface words. e.g.: "The port 

number". 

> Multi-level paths are separated by ">". Such as opening the 

local connection path description: Open "Control Panel> 

Network Connection> Local Area Connection". 

Light Blue Font It represents the words clicked to achieve hyperlink. The font 

color is as follows: ‘Light Blue’. 

Symbols 

Format Description 

Notice 

Remind the announcements in the operation, improper 

operation may result in data loss or equipment damage. 

Warning 

Pay attention to the notes on the mark, improper operation 

may cause personal injury. 

Note 

Make a necessary supplementary instruction for operation 

description. 



 

 

Format Description 

Key 

Configuration, operation, or tips for device usage. 

Tips 

Pay attention to the operation or information to ensure 

success device configuration or normal working. 

Revision Record 

Version No. Revision Date Revision Description 

01 2020-09-30 Product release 

02 2020-11-02 Upgrade 

03 2020-12-08 Add ARP Settings and Serial Port 

Configuration Instance 
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1 Log in the Web Interface 

1.1 WEB Browsing System Requirements 

Using this equipment, the system should meet the following conditions. 

Hardware and Software System Requirements 

CPU Above Pentium 586 

Memory Above 128MB 

Resolution Above 1024x768 

Color 256 color or above 

Browser Above Internet Explorer 6.0 

Operating system Windows XP/7/8/10 

 

1.2 Set the IP Address of the Computer 

The default management of device is as follows: 

IP Settings Default Value 

IP address 192.168.1.254 

Subnet mask 255.255.255.0 

 

Note 
 The network configuration of the device supports single IP and double IP modes, and 

the default is single IP mode. 
 In the single IP mode, the default IP address is 192.168.1.254, and the device WEB 

interface can be accessed through the connection port LINK1 or port LINK2. 
 In the dual IP mode, port LINK1 and port LINK2 have different IP addresses, so it is 

necessary to access the WEB interface according to the actual IP address. 



 

 

 

When configuring a device through the Web: 

 Before conducting remote configuration, please confirm the route between 

computer and device is reachable. 

 Before making a local configuration, make sure that the IP address of the computer 

and the serial server are on the same subnet. 

Notes: 

While configuring the device for the first time, if it's the local configuration mode, 

first confirm the network segment of current PC is 1. 

Eg: Assume that the IP address of the current PC is 192.168.5.60, change the network 

segment "5" of the IP address to "1". 

Operation Steps 

Amendment steps as follows: 

Step 1 Open "Control Panel> Network Connection> Local Area Connection> Properties> 

Internet Protocol Version 4 (TCP / IPv4)> Properties". 

Step 2 Change the selected "5" in red frame of the picture below to "1". 

 

Step 3 Click “OK”, IP address is modified successfully. 

Step 4 End. 



 

 

1.3 Log in the Web Configuration Interface 

Operation Steps 

PC is connected to the port LINK1 or LINK2 of the device, and the operation steps for 

logging into the WEB configuration interface are as follows: 

Step 1 Run the computer browser. 

Step 2 Enter the address of the device "http://192.168.1.254" in the address bar of the 

browser. 

Step 3 Click the “Enter” key. 

Step 4 Pop up a window as the figure below, enter the user name and password on the login 

window. 

 

Note: 

 The default user name and password for the serial server are "admin", which is 

strictly case-sensitive when typing. 
 Default username and password have the administrator privileges. 

Step 5 Click “Login”. 

Step 6 End. 

After login in successfully, user can configure relative parameters and information 

according to demands. 

Note: 

After logging in to the device, you can modify the IP address of the serial server for ease 

of use. 



 

 

2 Overview 

2.1 Device Information 

Function Description 

On the "Device information" page, you can view other device information such as device 

model, description information, software version, hardware version, running time, CPU 

utilization rate, memory utilization rate, etc. 

Operation Path 

Open in order: "Overview > Device information". 

Interface Description 

The Device information interface is as follows: 

 

Main element configuration description of Device information interface: 



 

 

Interface Element Description 

Device name Network identity or device type used by the device. 

Device model. Device model or port information. 

Serial No. Serial number of the device 

Software Version Current software version information, updated software 

version with more features. 

Device time The current device time display. synchronizes the local PC or 

NTP server time. 

Running time Running time of the current device. 

Description Description information of the device. 

Hardware Version Current hardware version information, pay attention to the 

hardware version limits in software version. 

Number of LANs The network port number of the device. 

Build date The newest build time of software version currently in use 

CPU Utilization CPU usage of the current device. 

Memory Utilization Memory usage of the current device. 

 

2.2 Network Information 

Function Description 

On the page of "Network information", user can check device network address 

information and DNS server information. 

Operation Path 

Open in order: "Overview > Network information". 

Interface Description 

Network information interface as follow: 



 

 

 

The main element configuration instructions in the network information interface 

Interface Element Description 

LAN1 LAN1 information bar 

IP configuration Shows how the LAN 1 of the device gets the IP address. 

Netmask Display device subnet mask. 

MAC address Display device LAN 1 MAC address. 

IP address Display LAN1 IP address. 

Gateway Display LAN1 gateway address. 

LAN2 Network card 2 information bar (dual-IP mode) 

IP configuration Shows how the LAN 2 of the device gets the IP address. 

Netmask Display device LAN2 subnet mask. 

MAC address Display device LAN 2 MAC address. 

IP address Display LAN2 IP address. 

Gateway Display LAN2 IP address. 

DNS server DNS server information bar 

DNS1 Display device main DNS server address. 

DNS2 Display device backup DNS server address. 

 



 

 

3 Network Configuration 

Function Description 

On the Network Configuration page, you can configure single IP or dual IP network 

mode, as well as device IP address and DNS server address. The device provides two 

Ethernet ports, which can work in redundant mode, switching mode and dual IP mode 

to meet the requirements of various network environments. The network address of the 

device supports DHCP/BOOTP protocol dynamic acquisition or manual static 

configuration. 

DNS, full Name Domain Name System. Domain DNS helps users find paths on the 

Internet. Every computer on the Internet has a unique address called an "IP address" 

(Internet protocol address). Because IP addresses (a string of Numbers) are hard to 

remember, DNS allows users to replace them with a common string of letters (" Domain 

Names "). 

DNS refers to the Domain Name Server. On the Internet, there is a one-to-one 

correspondence between domain names and IP addresses. Although domain names are 

easy for people to remember, machines can only know each other's IP addresses. The 

conversion between them is called domain name resolution which needs to be done by 

a dedicated domain name resolution server, DNS is the server for domain name 

resolution. 

Operation Path 

Open: “Network Configuration”. 

Interface Description 

Network Setting interface as follow: 



 

 

 

Network settings interface main element configuration instructions 

Interface Element Description 

Lan mode The network mode drop-down list of the device can be 

selected as follows: 

 Single IP: the device ports LINK1 and LINK2 are in the 

same network LAN1; 

 Dual IP: the device has dual IP and dual MAC addresses, 

with port LINK1 in network LAN1 and port LINK2 in 

network LAN2. 

Mode configuration In the single IP mode, the working mode of the equipment 

network port can be checked as follows: 

 Redundancy mode: Ports LINK1 and LINK2 are redundant 

ports, which support link backup. One port is in active 

state and one port is in backup state; 

 Switch mode: ports LINK1 and LINK2 are normal Ethernet 

ports. 

LAN1 LAN1 configuration bar 

LAN1 IP  

configuration 

Configuration of network address of device LAN 1: 

 DHCP: Automatically obtain dynamic IP address, subnet 

mask and default gateway address from DHCP server. 

 Static: manually configure IP address, subnet mask and 

default gateway address. 



 

 

Interface Element Description 

 BOOTP: Automatically obtain IP address, subnet mask 

and default gateway address from BOOTP(Bootstrap 

Protocol) server. 

LAN1 IP address Manually set the IP address of the device NIC 1, which is 

192.168.1.254 by default. 

LAN1 Subnet mask Manually set the subnet mask of the device NIC 1, which is 

255.255.255.0 by default. 

LAN1 gateway Fill in the gateway address information of device network card 

1, default is 192.168.1.1 

LAN2 LAN2 configuration bar (dual-IP mode) 

LAN2 IP 

configuration 

Configuration of network address of device LAN 2: 

 DHCP: Obtain an IP address, subnet mask, and default 

gateway address automatically from DHCP server. 

 Static: manually configure IP address, subnet mask and 

default gateway address. 

 BOOTP: Automatically obtain IP address, subnet mask 

and default gateway address from BOOTP(Bootstrap 

Protocol) server. 

LAN2 IP address Manually set the IP address of the device network card 2. 

LAN2 Subnet mask Manually set the subnet mask of device network card 2. 

LAN2 gateway Fill in the gateway address information of device network card 

2. 

DNS Settings DNS Settings column 

Primary DNS server DNS Sever IP address, for example: 202.96.133.4. 

Secondary DNS 

server 

DNS Sever backup IP address, for example: 202.96.133.5. 

 



 

 

4 Communication Parameters 

Function Description 

On the "Communication Parameters" page, you can view and configure the baud rate, 

parity bit, data bit, stop bit, flow control, interface type, FIFO function and RTS/DTR 

control of each serial port of the device. 

Operation Path 

Open: "Communication Parameters". 

Interface Description 

Communication Parameters interface is as follows: 

 

Main element configuration description of Communication Parameters interface: 

Interface Element Description 

Port Display device serial port number. 



 

 

Interface Element Description 

Serial name Enter the serial name for the corresponding serial number in 

the “Serial name” text box. 

Baud Rate Display serial port baud rate. 

Parity Display serial port parity bit. 

Data Bits Display serial port data bit. 

Stop Bits Display serial port stop bit. 

Flow Control Display whether the serial port flow control function is enabled. 

Interface  Display serial port interface mode. 

FIFO Display whether the serial port FIFO function is enabled. 

RTS control Displays the RTS pin control status of the corresponding serial 

port of the device. 

DTR control Display the DTR pin control status of the corresponding serial 

port of the device. 

Operate Click Edit to modify the serial port parameters of the 

corresponding serial port. 

 

Click Edit in the serial port entry to modify the current serial port parameters. 

Interface Description 

The Edit interface is as follows: 



 

 

 

The main element configuration description of serial port settings interface: 

Interface Element Description 

Port Numbers Display corresponding device serial port. 

Serial name The text box of serial port name, which supports 1-32 letters or 

numbers input, and can customize the name of the current 

serial port number. 

Baud Rate Choose baud rate of corresponding serial port. Unit: bps. 

Options: 

110/300/600/1200/2400/4800/9600/19200/38400/57600/115

200/230400/460800/921600 

Parity Select parity bits of corresponding serial number. Options: 

 None 

 Odd 

 Even 

 Mark 

 Space 



 

 

Interface Element Description 

Data Bits Select data bits of corresponding serial number. Options: 

 5 bits 

 6 bits 

 7 bits 

 8 bits 

Stop Bits Select stop bits of corresponding serial number. Options: 

 1 bits 

 2 bits 

Notes: 

When the data bit is 5bits, stop bit is 1bits and 1.5bits optional. 

Flow Control Flow control is used in two data transmission speed of different 

devices in the control of data flow technology to ensure that 

two devices communicate with each other to avoid data loss. 

Click the "flow control" drop-down list box, select the flow 

control parameters, the options are: 

 None 

 RTS/CTS 

 XON/XOFF 

 DTR/DSR 

Interface Determined by both hardware and software, options are as 

follows: 

 RS232 

 RS485 

 RS422 

FIFO  Enable or disable the FIFO function, if the serial device does not 

support data transceiver cache FIFO, FIFO function can be 

disabled to avoid data transmission errors. 

RTS control RTS pin can be controlled, the options are: 

 Auto 

 Force ON 

 Force OFF 

DTR control DTR pin can be controlled, the options are: 

 Auto 

 Force ON 

 Force OFF 

Apply the above 

setting to 

Check the serial port check box to apply the current settings to 

the specified serial port. 



 

 

 



 

 

5 Operation Modes 

Function Description 

On the "Operation Modes" page, you can configure the operation mode of the device 

corresponding to the serial port number. 

The working modes supported by the device are: 

 RealCom Mode 

 Reverse RealCom Mode 

 TCP Server Mode 

 TCP Client Mode 

 UDP Server Mode 

 UDP Client Mode 

 UDP Rang Mode 

 UDP Multicast Mode 

 Pair Slave Mode 

 Pair Master Mode 

 Telnet Mode 

 Reverse Telnet Mode 

 RFC2217 Mode 

 Redundant COM Mode 

 DRDAS RealCom Mode 

 DRDAS TCP Server Mode 

 Disable Mode 

Operation Path 

Open "operation modes > port 1 > operation modes" in order. Under the "Operation 

Modes" menu, access to different serial ports can configure the corresponding serial 

port information, and the WEB interface configuration operation mode of all serial ports 

is the same. 



 

 

5.1 RealCom Mode 

 

In RealCom mode, the serial port server and Windows / Linux operating system with the 

RealCOM drive work cooperatively. RealCom COM/TTY driver establishes a transparent 

or secure network transmission connection between the host and the serial device in 

the operating system. Map the serial port of the serial port server to the local COM/TTY 

device of the host according to the user configured serial server IP address and serial 

port number and other parameters. The original serial device software or 

communication module without modification can be used directly without modification. 

The RealCom driver gets the data be sent to the local COM / TTY device of the host, then 

sends it over Ethernet in the form of TCP / IP packet. At the other end of the 

transmission, the serial server will receive the TCP / IP packet and analyse the packet, 

and after unpacking send the original data to the serial device through the 

corresponding serial port, and vice versa. 

Interface Description 

The interface of RealCom Mode is as follows: 



 

 

 

Main element configuration instructions in RealCom Mode interface 

Interface Element Description 

Operation mode Operation Mode Configuration Bar 

Serial Num Displays the serial number of the device currently configured. 

Operation mode The operation modes of serial port of the device are as 

follows: 

 RealCom Mode 

 Reverse RealCom Mode 

 TCP Server Mode 

 TCP Client Mode 

 UDP Server Mode 



 

 

Interface Element Description 

 UDP Client Mode 

 UDP Rang Mode 

 UDP Multicast Mode 

 Pair Slave Mode 

 Pair Master Mode 

 Telnet Mode 

 Reverse Telnet Mode 

 RFC2217 Mode 

 Redundant COM Mode 

 DRDAS RealCom Mode 

 DRDAS TCP Server Mode 

 Disable Mode 

RealCom Mode RealCom Mode configuration bar 

Max connection The number of host that one serial port connects to. 

 Each host communicates with serial port in the order of 

first-in first-out; 

 The system supports up to 4 connections. 

TCP alive check time If there isn't any TCP activity within schedule time, the system 

will automatically send connection detection message and 

check whether the TCP connection is valid. If the reply packet 

of opposite side hasn't been received after sending probe 

packet for 3 times, system will regard the opposite side as 

down and forwardly close the communication connection. 

Queue access With multiple host connections, the command mode only 

supports one request and one response from each host, and 

one response data can be cached in response to other same 

requests. Options are as follows: 

 Enable; 

 Disable; 

Note: 

Command mode is enabled when the number of connections is 

greater than 1. 

Response timeout Time interval that allows the serial server to respond to each 

host's request, the communication between serial server and 

host is deemed to be completed after schedule time, serial 

server continues to deal with the next host request. 



 

 

Interface Element Description 

Frame break The processing mode of serial port data with no request and 

automatic response of serial port equipment is as follows: 

 Discard: discard the unrequested serial data; 

 Transmit to the last communication connection: transmit 

the unrequested serial port data to the last 

communication connection; 

 Transmit to all open connection: transmit the 

unrequested serial port data to all open connection; 

Advanced Settings Advanced Settings Configuration Bar 

Packing mode Serial port data packaging Ethernet data time, the options are 

as follows: 

 Interval: after sending the last Ethernet packet for some 

time, the system packages the received serial port data 

into Ethernet packets and sends them out; 

 Forced time: the system packages serial port data 

received within a specified time into Ethernet packets and 

transmit them. 

Packet length The frame length of serial data to Ethernet data. In the set 

time range, the data forwards when it is greater than or 

equals to the set frame length. The value range is 0~1024. It 

means no limit on data transmission length when it’ set to 0. 

Note: 

There are some slight deviations between the actual package 

length value and the set value. 

Delimiter Select the number of delimited characters, the options are as 

follows: 

 Disable: disable delimiter function; 

 1: Enable Delimiter 1; 

 2: enable delimiter 2. 

Notes: 

If the packaging length or the forced transfer time is 0 and the 

number of delimited character is greater than 0, the system 

would detect and process the delimiter after receiving serial 

data. Every time it receives matched delimiter (or combination 

of characters), the system would send out all cached serial data 

via network. 

Delimiter 1 Delimiter 1, adopts hexadecimal, with a value range of 00-ff. 

Delimiter 2 Delimiter 2, adopts hexadecimal, with a value range of 00-ff. 

Delimiter process Select the delimiter processing method. Options: 



 

 

Interface Element Description 

 Retain: the system would send out the received delimiter 

and other data via network. 

 Delimiter+1: the system transfers data after receiving a 

delimiter and an extra byte. 

 Delimiter+2: the system transfers data after receiving a 

delimiter and 2 extra bytes. 

 Delete: the matched delimiter (or combination of 

delimiter) would be deleted. The system only transmits 

data except delimiter. 

Force transmit If the transmission time is greater than 0, the system sends 

the serial data received within the specified time through a 

packet, in the range of 0 to 65535 ms. When the transfer time 

is 0, it means that the data transmission interval is not 

restricted. 

Apply to all ports Check the “Apply to all port” check box to apply the current 

settings to all serial ports. 

 

Notice 

 When the maximum number of connections is greater than 1, set the parameters to 

be consistent when multiple hosts are connected to the same serial port, otherwise 

it will cause communication error. 

 Communication Parameters of real serial port will be automatically changed 

according to communication parameters of virtual serial port, and real-time 

communication parameters of serial port of serial port server can be viewed 

through "Communication Parameters". 

 



 

 

5.2 Reverse RealCom Mode 

 

When serial server uses private IP address or is in a dynamic IP address environment, 

the RealCOM mode will not work. Under this circumstance, both remote host/server 

cannot connect to serial server. At this point, establish connection via reverse RealCOM, 

the serial server would send request and connect to remote host/server that has 

installed COM/TTY drivers, and map the serial port of the serial server to the local 

COM/TTY device of the host. The software or communication module of the original 

serial device could be used directly without modification. 

The RealCom driver gets the data be sent to the local COM / TTY device of the host, then 

sends it over Ethernet in the form of TCP / IP packet. At the other end of the 

transmission, the serial server will receive the TCP / IP packet and analyse the packet, 

and after unpacking send the original data to the serial device through the 

corresponding serial port, and vice versa. 

Interface Description 

Reverse RealCom Mode interface is as follows: 



 

 

 

Reverse RealCom Mode interface main element configuration instructions: 

Interface Element Description 

Operation mode Operation Mode Configuration Bar 

Serial num Displays the serial number of the device currently configured. 

Operation mode The working modes of serial port of the device are as follows: 

 RealCom Mode 

 Reverse RealCom Mode 

 TCP Server Mode 

 TCP Client Mode 

 UDP Server Mode 

 UDP Client Mode 

 UDP Rang Mode 

 UDP Multicast Mode 

 Pair Slave Mode 

 Pair Master Mode 

 Telnet Mode 

 Reverse Telnet Mode 

 RFC2217 Mode 



 

 

Interface Element Description 

 Redundant COM Mode 

 DRDAS RealCom Mode 

 DRDAS TCP Server Mode 

 Disable Mode 

Reverse RealCom 

Mode 

Reverse RealCom Mode Configuration Bar 

TCP alive check 

time 

If there isn't any TCP activity within schedule time, the system 

will automatically send connection detection message and 

check whether the TCP connection is valid. If the reply packet 

of opposite side hasn't been received after sending probe 

packet for 3 times, system will regard the opposite side as 

down and forwardly close the communication connection. 

Inactivity time Set the TCP timeout for the serial server's current data 

communication link. 

 If the idle time-out during communication is larger than 0, 

the system would close the TCP connection without any 

data transmission activity occurring in the specified time 

automatically. 

 0 means the free TCP connection would not be closed 

automatically. 

Destination IP 

address 1 

Specify device to connect to the IP address 1 of remote 

host/server, such as 10.0.0.2. 

Destination tcp 

port 

The data port number of destination IP address 1, ranging from 

0 to 65535. 

Note: 

Make sure the port is not blocked by the firewall or occupied by 

other programs when using port numbers. 

Destination cmd 

port 

The command port number of destination IP address 1, ranging 

from 0 to 65535. 

Destination IP 

address 2 

Specify device to connect to the IP address 2 of remote 

host/server, such as 10.0.0.2. 

Destination tcp 

port 

The data port number of destination IP address 2, ranging from 

0 to 65535. 

Note: 

Make sure the port is not blocked by the firewall or occupied by 

other programs when using port numbers. 

Destination cmd 

port 

The command port number of destination IP address 2, ranging 

from 0 to 65535. 



 

 

Interface Element Description 

Designated local  

tcp port1 

Local data port 1 that device and destination IP address 1 

connect, options are as follows: 

 Enable: configure a specific local data port manually when 

enabled. 

 Disable: system distributes local data port automatically 

when disable. 

Designated  local 

cmd port1 

Local command port 1 that device and destination IP address 1 

connect, options are as follows: 

 Enable: configure a specific local command port manually 

when enabled. 

 Disable: system distributes local command port 

automatically when disabled. 

Designated local 

tcp port2 

Local data port 2 that device and destination IP address 2 

connect, options are as follows: 

 Enable: configure a specific local data port manually when 

enabled. 

 Disable: system distributes local data port automatically 

when disable. 

Designated local 

cmd port2 

Local command port 2 that device and destination IP address 2 

connect, options are as follows: 

 Enable: configure a specific local command port manually 

when enabled. 

 Disable: system distributes local command port 

automatically when disabled. 

Advanced Settings Advanced Settings Configuration Bar 

Packing mode Serial port data packaging Ethernet data time, the options are 

as follows: 

 Interval: after sending the last Ethernet packet for some 

time, the system packages the received serial port data 

into Ethernet packets and sends them out; 

 Forced time: the system packages serial port data received 

within a specified time into Ethernet packets and transmit 

them. 

Packet length The frame length of serial data to Ethernet data. In the set time 

range, the data forwards when it is greater than or equals to 

the set frame length. The value range is 0~1460. It means no 

limit on data transmission length when it’ set to 0. 



 

 

Interface Element Description 

Note: 

There are some slight deviations between the actual package 

length value and the set value. 

Delimiter Select the number of delimited characters, the options are as 

follows: 

 Disable: disable delimiter function; 

 1: Enable Delimiter 1 

 2: enable delimiter 2. 

Note: 

If the packaging length or the forced transfer time is 0 and the 

number of delimited character is greater than 0, the system 

would detect and process the delimiter after receiving serial 

data. Every time it receives matched delimiter (or combination 

of characters), the system would send out all cached serial data 

via network. 

Delimiter 1 Delimiter 1, adopts hexadecimal, with a value range of 00-ff. 

Delimiter 2 Delimiter 2, adopts hexadecimal, with a value range of 00-ff. 

Delimiter process Select the delimiter processing method. Options: 

 Retain: the system would send out the received delimiter 

and other data via network. 

 Delimiter+1: the system transfers data after receiving a 

delimiter and an extra byte. 

 Delimiter+2: the system transfers data after receiving a 

delimiter and 2 extra bytes. 

 Delete: the matched delimiter (or combination of 

delimiter) would be deleted. The system only transmits 

data except delimiter. 

Force transmit If the transmission time is greater than 0, the system sends the 

serial data received within the specified time through a packet, 

in the range of 0 to 65535 ms. When the transfer time is 0, it 

means that the data transmission interval is not restricted. 

Apply to all ports Check the “Apply to all port” check box to apply the current 

settings to all serial ports. 

 

Notice 

Communication Parameters of real serial port will be automatically changed according 

to communication parameters of virtual serial port, and real-time communication 

parameters of serial port of serial port server can be viewed through "Communication 

Parameters” page. 



 

 

5.3 TCP Server Mode 

 

In the TCP server mode, the serial device server is assigned an IP port number, waiting 

for the host connection passively. When the host initiates a connection request and 

establishes a connection with the serial device server, the host can realize bidirectional 

transparent or encrypted data transmission through the network connection and the 

serial port. The TCP server mode supports up to four session connections 

simultaneously, allowing multiple hosts to simultaneously read or send Ethernet data to 

a serial device. 

Interface Description 

TCP server mode interface is as follows: 



 

 

 

TCP server mode interface main element configuration instructions: 

Interface Element Description 

Operation mode Operation Mode Configuration Bar 

Serial Num Displays the serial number of the device currently configured. 

Operation mode The operation modes of serial port of the device are as follows: 

 RealCom Mode 



 

 

Interface Element Description 

 Reverse RealCom Mode 

 TCP Server Mode 

 TCP Client Mode 

 UDP Server Mode 

 UDP Client Mode 

 UDP Rang Mode 

 UDP Multicast Mode 

 Pair Slave Mode 

 Pair Master Mode 

 Telnet Mode 

 Reverse Telnet Mode 

 RFC2217 Mode 

 Redundant COM Mode 

 DRDAS RealCom Mode 

 DRDAS TCP Server Mode 

 Disable Mode 

TCP Server Mode TCP Server Mode Configuration bar 

Max connection The number of host that one serial port connects to. 

 Each host communicates with serial port in the order of 

first-in first-out; 

 The system supports up to 4 connections. 

Preempt 

connection 

When exceed the maximum number of connection request, the 

number of sessions that have established TCP connections can 

be preempted, options are as follows: 

 Disable: established TCP link are not allowed to be 

preempted; 

 First connection: the TCP link that first establishes will be 

preempted; 

 Longest uncommunicated: the longest uncommunicated 

TCP link will be preempted. 

Local port The destination connection port of TCP client. 

Password check After the device is connected with the remote client, the peer 

client needs to send the authentication password to the device. 

After the password is verified, the client can communicate with 

the device. Options: 

 Enable: Enable password verification function. 

 Disable: Disable password verification function. 

Note: 



 

 

Interface Element Description 

When password verification is enabled, only users with "admin" 

account privileges can send / receive messages using this device. 

 The first data sent by the peer client to the device defaults to 

the check password. 

 Verification password is "admin" account password. 

 If the password is entered incorrectly, re-establish the 

connection and then re-enter the password. 

Port 

buffering(128K) 

Port data cache, which can cache serial port data up to 128K 

after the port is disconnected. When the network returns to 

normal, the cached data is forwarded. The tick options are as 

follows: 

 Enable 

 Disable 

Send message The information sent after the device is connected to the peer 

client. Options: 

 Ipaddr: After the connection is successful, send the IP 

address of the device to the remote client. 

 Devicename: After the connection is successful, send the 

devicename of the device to the remote client. 

 turnoff: After the connection is successful, no information 

is sent to the peer client. 

TCP alive check 

time 

If there isn't any TCP activity within schedule time, the system 

will automatically send connection detection message and 

check whether the TCP connection is valid. If the reply packet of 

opposite side hasn't been received after sending probe packet 

for 3 times, system will regard the opposite side as down and 

forwardly close the communication connection. 

Inactivity time Set the TCP timeout for the serial server's current data 

communication link. 

If the idle time-out during communication is larger than 0, the 

system would close the TCP connection without any data 

transmission activity occurring in the specified time 

automatically. 0 means the free TCP connection would not be 

closed automatically. 

Queue access With multiple host connections, the command mode only 

supports one request and one response from each host, and 



 

 

Interface Element Description 

one response data can be cached in response to other same 

requests. Options are as follows: 

 Enable; 

 Disable; 

Note: 

Command mode is enabled when the number of connections is 

greater than 1. 

Response timeout Time interval that allows the serial server to respond to each 

host's request, the communication between serial server and 

host is deemed to be completed after schedule time, serial 

server continues to deal with the next host request. 

Frame break The processing mode of serial port data with no request and 

automatic response of serial port equipment is as follows: 

 Discard: discard the unrequested serial data; 

 Transmit to the last communication connection: transmit 

the unrequested serial port data to the last communication 

connection; 

 Transmit to all open connection: transmit the unrequested 

serial port data to all open connection; 

Advanced Settings Advanced Settings Configuration Bar 

Packing mode Serial port data packaging Ethernet data time, the options are 

as follows: 

 Interval: after sending the last Ethernet packet for some 

time, the system packages the received serial port data 

into Ethernet packets and sends them out; 

 Forced time: the system packages serial port data received 

within a specified time into Ethernet packets and transmit 

them. 

Packet length The frame length of serial data to Ethernet data. In the set time 

range, the data forwards when it is greater than or equals to 

the set frame length. The value range is 0~1460. It means no 

limit on data transmission length when it’ set to 0. 

Note: 

There are some slight deviations between the actual package 

length value and the set value. 

Delimiter Select the number of delimited characters, the options are as 

follows: 

 Disable: disable delimiter function; 
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 1: Enable Delimiter 1 

 2: enable delimiter 2. 

Note: 

If the packaging length or the forced transfer time is 0 and the 

number of delimited character is greater than 0, the system 

would detect and process the delimiter after receiving serial data. 

Every time it receives matched delimiter (or combination of 

characters), the system would send out all cached serial data via 

network. 

Delimiter 1 Delimiter 1, adopts hexadecimal, with a value range of 00-ff. 

Delimiter 2 Delimiter 2, adopts hexadecimal, with a value range of 00-ff. 

Delimiter process Select the delimiter processing method. Options: 

 Retain: the system would send out the received delimiter 

and other data via network. 

 Delimiter+1: the system transfers data after receiving a 

delimiter and an extra byte. 

 Delimiter+2: the system transfers data after receiving a 

delimiter and 2 extra bytes. 

 Delete: the matched delimiter (or combination of 

delimiter) would be deleted. The system only transmits 

data except delimiter. 

Force transmit If the transmission time is greater than 0, the system sends the 

serial data received within the specified time through a packet, 

in the range of 0 to 65535 ms. When the transfer time is 0, it 

means that the data transmission interval is not restricted. 

Apply to all ports Check the “Apply to all ports” check box to apply the current 

settings to all serial ports. 

 



 

 

5.4 TCP Client Mode 

 

In the TCP client mode, the serial device server can automatically establish a network 

connection with the host specified by the user when the serial data arrives. When the 

data transmission is completed, the serial server will automatically shut down the 

network connection according to the parameters such as TCP alive time and TCP idle 

timeout time. Similarly, TCP client mode can support up to four session connections at 

the same time, so that multiple hosts can simultaneously read or send Ethernet data to 

a serial device. 

Interface Description 

TCP Client mode interface is as follows: 



 

 

 

TCP client mode interface main element configuration instructions: 

Interface Element Description 

Operation mode Operation Mode Configuration Bar 

Serial Num Displays the serial number of the device currently configured. 

Operation mode The operation modes of serial port of the device are as follows: 

 RealCom Mode 

 Reverse RealCom Mode 

 TCP Server Mode 

 TCP Client Mode 

 UDP Server Mode 

 UDP Client Mode 

 UDP Rang Mode 

 UDP Multicast Mode 

 Pair Slave Mode 



 

 

Interface Element Description 

 Pair Master Mode 

 Telnet Mode 

 Reverse Telnet Mode 

 RFC2217 Mode 

 Redundant COM Mode 

 DRDAS RealCom Mode 

 DRDAS TCP Server Mode 

 Disable Mode 

TCP Client Mode TCP Client Mode Configuration Bar 

Max connection The number of host that one serial port connects to. 

 Each host communicates with serial port in the order of 

first-in first-out; 

 The system supports up to 4 connections. 

SessionID The number of TCP connection sessions corresponds to the 

maximum number of connections. 

Format Dest Address Format, options are as follows: 

 IP: destination address is in IP address format; 

 DNS: destination address is in DNS domain name address 

format. 

Destination 

addresses 

Enter the IP address of the server to be connected by the serial 

device server. 

Destination port Enter the TCP port number of the server to be connected by the 

serial device server. 

Local port The serial server provides a local service or connection port 

number for the TCP connection that is used to connect and 

communicate with the server. 

Port bind Local port fixed, options are as follows: 

 Disable: the system automatically selects the idle local port 

to establish a connection with the server; 

 Enable: connect to the server using a manually configured 

local port. 

Password check After the device is connected with the remote client, the peer 

client needs to send the authentication password to the device. 

After the password is verified, the client can communicate with 

the device. Options: 

 Enable: Enable password verification function. 

 Disable: Disable password verification function. 



 

 

Interface Element Description 

Note: 

When password verification is enabled, only users with "admin" 

account privileges can send / receive messages using this device. 

 The first data sent by the peer client to the device defaults to 

the check password. 

 Verification password is "admin" account password. 

 If the password is entered incorrectly, re-establish the 

connection and then re-enter the password. 

Port 

buffering(128K) 

Port data cache, which can cache serial port data up to 128K 

after the port is disconnected. When the network returns to 

normal, the cached data is forwarded. The tick options are as 

follows: 

 Enable 

 Disable 

Send message The information sent after the device is connected to the peer 

client. Options: 

 Ipaddr: After the connection is successful, send the IP 

address of the device to the remote client. 

 Devicename: After the connection is successful, send the 

devicename of the device to the remote client. 

 turnoff: After the connection is successful, no information 

is sent to the peer client. 

Control connection  Select how the serial server initiates a connection request. 

Options: 

 Always: Immediately after the system is started, it tries to 

establish a connection with the target host and 

automatically reconnects the target host after the 

connection is disconnected. 

 Char: Automatically connects to the target host when 

receiving data from the serial port. 

 DSROn: Automatically connects to the target host when 

the DSR signal is detected. 

 DCDOn: Automatically connects to the target host when 

the DCD signal is detected. 

Control 

disconnection 

Select how the serial server is disconnected. Options: 

 None: Never shut down the network connection 

automatically. 
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 DSROff: Automatically shuts down the network connection 

when the DSR signal is detected invalid. 

 DCDOff: Automatically shuts down the network connection 

when the DCD signal is detected invalid. 

 Idle: If the idle timeout time is greater than 0, the system 

will automatically shut down TCP connections that do not 

have any data send and receive activity for a specified 

period of time. 

TCP alive check 

time 

If there isn't any TCP activity within schedule time, the system 

will automatically send connection detection message and 

check whether the TCP connection is valid. If the reply packet of 

opposite side hasn't been received after sending probe packet 

for 3 times, system will regard the opposite side as down and 

forwardly close the communication connection. 

Inactivity time Set the TCP timeout for the serial server's current data 

communication link. 

If the idle time-out during communication is larger than 0, the 

system would close the TCP connection without any data 

transmission activity occurring in the specified time 

automatically. 0 means the free TCP connection would not be 

closed automatically. 

Advanced Settings Advanced Settings Configuration Bar 

Packing mode Serial port data packaging Ethernet data time, the options are 

as follows: 

 Interval: after sending the last Ethernet packet for some 

time, the system packages the received serial port data 

into Ethernet packets and sends them out; 

 Forced time: the system packages serial port data received 

within a specified time into Ethernet packets and transmit 

them. 

Packet length The frame length of serial data to Ethernet data. In the set time 

range, the data forwards when it is greater than or equals to 

the set frame length. The value range is 0~1024. It means no 

limit on data transmission length when it’ set to 0. 

Note: 

There are some slight deviations between the actual package 

length value and the set value. 



 

 

Interface Element Description 

Delimiter Select the number of delimited characters, the options are as 

follows: 

 Disable: disable delimiter function; 

 1: Enable Delimiter 1 

 2: enable delimiter 2. 

Note: 

If the packaging length or the forced transfer time is 0 and the 

number of delimited character is greater than 0, the system 

would detect and process the delimiter after receiving serial data. 

Every time it receives matched delimiter (or combination of 

characters), the system would send out all cached serial data via 

network. 

Delimiter 1 Delimiter 1, adopts hexadecimal, with a value range of 00-ff. 

Delimiter 2 Delimiter 2, adopts hexadecimal, with a value range of 00-ff. 

Delimiter process Select the delimiter processing method. Options: 

 Retain: the system would send out the received delimiter 

and other data via network. 

 Delimiter+1: the system transfers data after receiving a 

delimiter and an extra byte. 

 Delimiter+2: the system transfers data after receiving a 

delimiter and 2 extra bytes. 

 Delete: the matched delimiter (or combination of 

delimiter) would be deleted. The system only transmits 

data except delimiter. 

Force transmit If the transmission time is greater than 0, the system sends the 

serial data received within the specified time through a packet, 

in the range of 0 to 65535 ms. When the transfer time is 0, it 

means that the data transmission interval is not restricted. 

Apply to all ports Check the “Apply to all port” check box to apply the current 

settings to all serial ports. 

 

Notice 

The TCP timeout takes effect only when "Disconnect control" is set to "idle". 

 



 

 

5.5 UDP Server Mode 

 

In UDP server mode, the serial server through the UDP protocol and user-specified host 

for serial data transmission. UDP mode serial device server can transfer data from the 

serial device to one or more hosts, and the serial device server can also receive data 

from one or more hosts. Compared with TCP mode, UDP protocol is faster and more 

efficient. 

Interface Description 

TCP Server Mode interface is as follows: 



 

 

 

UDP Server Mode interface main element configuration instructions 

Interface Element Description 

Operation mode Operation Mode Configuration Bar 

Serial Num Displays the serial number of the device currently configured. 

Operation mode The operation modes of serial port of the device are as follows: 

 RealCom Mode 

 Reverse RealCom Mode 

 TCP Server Mode 

 TCP Client Mode 

 UDP Server Mode 
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 UDP Client Mode 

 UDP Rang Mode 

 UDP Multicast Mode 

 Pair Slave Mode 

 Pair Master Mode 

 Telnet Mode 

 Reverse Telnet Mode 

 RFC2217 Mode 

 Redundant COM Mode 

 DRDAS RealCom Mode 

 DRDAS TCP Server Mode 

 Disable Mode 

UDP Server Mode TCP Server Mode Configuration Bar 

Max connection The number of host that one serial port connects to. 

 Each host communicates with serial port in the order of 

first-in first-out; 

 The system supports up to 4 connections. 

Local listen port The network receives the listening port of UDP data. The user 

must assign a unique listening port to each serial port so that 

the system can normally receive UDP data. 

Advanced Settings Advanced Settings Configuration Bar 

Packing mode Serial port data packaging Ethernet data time, the options are 

as follows: 

 Interval: after sending the last Ethernet packet for some 

time, the system packages the received serial port data 

into Ethernet packets and sends them out; 

 Forced time: the system packages serial port data received 

within a specified time into Ethernet packets and transmit 

them. 

Packet length The frame length of serial data to Ethernet data. In the set time 

range, the data forwards when it is greater than or equals to 

the set frame length. The value range is 0~1024. It means no 

limit on data transmission length when it’ set to 0. 

Note: 

There are some slight deviations between the actual package 

length value and the set value. 

Delimiter Select the number of delimited characters, the options are as 

follows: 
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 Disable: disable delimiter function; 

 1: Enable Delimiter 1 

 2: enable delimiter 2. 

Note: 

If the packaging length or the forced transfer time is 0 and the 

number of delimited character is greater than 0, the system 

would detect and process the delimiter after receiving serial data. 

Every time it receives matched delimiter (or combination of 

characters), the system would send out all cached serial data via 

network. 

Delimiter 1 Delimiter 1, adopts hexadecimal, with a value range of 00-ff. 

Delimiter 2 Delimiter 2, adopts hexadecimal, with a value range of 00-ff. 

Delimiter process Select the delimiter processing method. Options: 

 Retain: the system would send out the received delimiter 

and other data via network. 

 Delimiter+1: the system transfers data after receiving a 

delimiter and an extra byte. 

 Delimiter+2: the system transfers data after receiving a 

delimiter and 2 extra bytes. 

 Delete: the matched delimiter (or combination of 

delimiter) would be deleted. The system only transmits 

data except delimiter. 

Force transmit If the transmission time is greater than 0, the system sends the 

serial data received within the specified time through a packet, 

in the range of 0 to 65535 ms. When the transfer time is 0, it 

means that the data transmission interval is not restricted. 

Apply to all ports Check the “Apply to all port” check box to apply the current 

settings to all serial ports. 

 



 

 

5.6 UDP Client Mode 

 

In UDP server mode, the serial server through the UDP protocol and user-specified host 

for serial data transmission. UDP mode serial device server can transfer data from the 

serial device to one or more hosts, and the serial device server can also receive data 

from one or more hosts. Compared with TCP mode, UDP protocol is faster and more 

efficient. 

Interface Description 

UDP Client Mode interface is as follows: 



 

 

 

UDP Client Mode interface main element configuration instructions: 

Interface Element Description 

Operation mode Operation Mode Configuration Bar 

Serial Num Displays the serial number of the device currently configured. 

Operation mode The operation modes of serial port of the device are as follows: 

 RealCom Mode 

 Reverse RealCom Mode 

 TCP Server Mode 

 TCP Client Mode 

 UDP Server Mode 

 UDP Client Mode 

 UDP Rang Mode 

 UDP Multicast Mode 
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 Pair Slave Mode 

 Pair Master Mode 

 Telnet Mode 

 Reverse Telnet Mode 

 RFC2217 Mode 

 Redundant COM Mode 

 DRDAS RealCom Mode 

 DRDAS TCP Server Mode 

 Disable Mode 

UDP Client Mode UDP Client Mode Configuration Bar 

Max connection The number of host that one serial port connects to. 

 Each host communicates with serial port in the order of 

first-in first-out; 

 The system supports up to 4 connections. 

SessionID The number of TCP connection sessions corresponds to the 

maximum number of connections. 

Format Destination address format. 

Destination 

address 

Enter the IP address of the server to be connected by the serial 

device server. 

Destination port Enter the TCP port number of the server to be connected by the 

serial device server. 

Advanced Settings Advanced Settings Configuration Bar 

Packing mode Serial port data packaging Ethernet data time, the options are 

as follows: 

 Interval: after sending the last Ethernet packet for some 

time, the system packages the received serial port data 

into Ethernet packets and sends them out; 

 Forced time: the system packages serial port data received 

within a specified time into Ethernet packets and transmit 

them. 

Packet length The frame length of serial data to Ethernet data. In the set time 

range, the data forwards when it is greater than or equals to 

the set frame length. The value range is 0~1460. It means no 

limit on data transmission length when it’ set to 0. 

Note: 

There are some slight deviations between the actual package 

length value and the set value. 
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Delimiter Select the number of delimited characters, the options are as 

follows: 

 Disable: disable delimiter function; 

 1: Enable Delimiter 1 

 2: enable delimiter 2. 

Note: 

If the packaging length or the forced transfer time is 0 and the 

number of delimited character is greater than 0, the system 

would detect and process the delimiter after receiving serial data. 

Every time it receives matched delimiter (or combination of 

characters), the system would send out all cached serial data via 

network. 

Delimiter 1 Delimiter 1, adopts hexadecimal, with a value range of 00-ff. 

Delimiter 2 Delimiter 2, adopts hexadecimal, with a value range of 00-ff. 

Delimiter process Select the delimiter processing method. Options: 

 Retain: the system would send out the received delimiter 

and other data via network. 

 Delimiter+1: the system transfers data after receiving a 

delimiter and an extra byte. 

 Delimiter+2: the system transfers data after receiving a 

delimiter and 2 extra bytes. 

 Delete: the matched delimiter (or combination of 

delimiter) would be deleted. The system only transmits 

data except delimiter. 

Force transmit If the transmission time is greater than 0, the system sends the 

serial data received within the specified time through a packet, 

in the range of 0 to 65535 ms. When the transfer time is 0, it 

means that the data transmission interval is not restricted. 

Apply to all ports Check the “Apply to all port” check box to apply the current 

settings to all serial ports. 

 



 

 

5.7 UDP Rang Mode 

 

When the routers and switches and other devices do not support multicast, but also 

need to achieve the multicast function, you can make the serial server in UDP rang 

mode. In this mode, the serial server through the UDP protocol with the user specified 

the same network segment of the host advance serial data transmission, to achieve 

point to multipoint data communication. UDP port mode serial device can also receive 

data from one or more hosts. 

Interface Description 

UDP Rang Mode interface as follows: 



 

 

 

UDP Rang Mode interface main element configuration instructions: 

Interface Element Description 

Operation mode Operation Mode Configuration Bar 

Serial Num Displays the serial number of the device currently configured. 

Operation mode The operation modes of serial port of the device are as follows: 

 RealCom Mode 

 Reverse RealCom Mode 

 TCP Server Mode 

 TCP Client Mode 

 UDP Server Mode 

 UDP Client Mode 

 UDP Rang Mode 
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 UDP Multicast Mode 

 Pair Slave Mode 

 Pair Master Mode 

 Telnet Mode 

 Reverse Telnet Mode 

 RFC2217 Mode 

 Redundant COM Mode 

 DRDAS RealCom Mode 

 DRDAS TCP Server Mode 

 Disable Mode 

UDP Rang Mode UDP Rang Mode Configuration Bar 

Max connection The number of host that one serial port connects to. 

 Each host communicates with serial port in the order of 

first-in first-out; 

 The system supports up to 4 connections. 

SessionID The number of TCP connection sessions corresponds to the 

maximum number of connections. 

Format  Destination address format. 

Start Address Enter the start IP address of the UDP rang destination address. 

End Address Enter the end IP address of the UDP rang destination address. 

Destination Port Enter the port number of the host that will be connected by 

serial device server. 

Local listen port The network receives the listening port of UDP data. The user 

must assign a unique listening port to each serial port so that 

the system can normally receive UDP data. 

Advanced Settings Advanced Settings Configuration Bar 

Packing mode Serial port data packaging Ethernet data time, the options are 

as follows: 

 Interval: after sending the last Ethernet packet for some 

time, the system packages the received serial port data 

into Ethernet packets and sends them out; 

 Forced time: the system packages serial port data received 

within a specified time into Ethernet packets and transmit 

them. 

Packing length The frame length of serial data to Ethernet data. In the set time 

range, the data forwards when it is greater than or equals to 
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the set frame length. The value range is 0~1024. It means no 

limit on data transmission length when it’ set to 0. 

Note: 

There are some slight deviations between the actual package 

length value and the set value. 

Delimiter Select the number of delimited characters, the options are as 

follows: 

 Disable: disable delimiter function; 

 1: Enable Delimiter 1 

 2: enable delimiter 2. 

Note: 

If the packaging length or the forced transfer time is 0 and the 

number of delimited character is greater than 0, the system 

would detect and process the delimiter after receiving serial data. 

Every time it receives matched delimiter (or combination of 

characters), the system would send out all cached serial data via 

network. 

Delimiter 1 Delimiter 1, adopts hexadecimal, with a value range of 00-ff. 

Delimiter 2 Delimiter 2, adopts hexadecimal, with a value range of 00-ff. 

Delimiter process Select the delimiter processing method. Options: 

 Retain: the system would send out the received delimiter 

and other data via network. 

 Delimiter+1: the system transfers data after receiving a 

delimiter and an extra byte. 

 Delimiter+2: the system transfers data after receiving a 

delimiter and 2 extra bytes. 

 Delete: the matched delimiter (or combination of 

delimiter) would be deleted. The system only transmits 

data except delimiter. 

Force transmit If the transmission time is greater than 0, the system sends the 

serial data received within the specified time through a packet, 

in the range of 0 to 65535 ms. When the transfer time is 0, it 

means that the data transmission interval is not restricted. 

Apply to all ports Check the “Apply to all port” check box to apply the current 

settings to all serial ports. 

 



 

 

5.8 UDP Multicast Mode 

 

In UDP multicast mode, the serial server can send unicast or multicast data of the serial 

device to one or more hosts specified by the user through the UDP protocol, and can 

also receive unicast or multicast data from one or more devices, enabling multipoint-to-

multipoint communication. 

Interface Description 

UDP Multicast Mode interface as follows: 



 

 

 

UDP Multicast Mode interface main element configuration instructions: 

Interface Element Description 

Operation mode Working Mode Configuration Bar 

Serial Num Displays the serial number of the device currently 

configured. 

Operation mode The working modes of serial port of the device are as 

follows: 

 RealCom Mode 

 Reverse RealCom Mode 

 TCP Server Mode 

 TCP Client Mode 

 UDP Server Mode 

 UDP Client Mode 
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 UDP Rang Mode 

 UDP Multicast Mode 

 Pair Slave Mode 

 Pair Master Mode 

 Telnet Mode 

 Reverse Telnet Mode 

 RFC2217 Mode 

 Redundant COM Mode 

 DRDAS RealCom Mode 

 DRDAS TCP Server Mode 

 Disable Mode 

UDP Multicast Mode UDP Multicast Mode Configuration Bar 

Max connection The number of host that one serial port connects to. 

 Each host communicates with serial port in the order of 

first-in first-out; 

 The system supports up to 4 connections. 

Group Number Select the number of multicast groups and support up to 

four multicast groups. 

Local listen port The network receives the listening port of UDP data. The 

user must assign a unique listening port to each serial port so 

that the system can normally receive UDP data. 

Destination  

addresses 

Enter the IP address of the host that will be connected by 

serial device server. 

Destination Port Enter the port number of the host that will be connected by 

serial device server. 

Multicast address Group address is used for identifying an IP multicast group, 

multicast address range is: 224.0.0.0 ~ 239.255.255.255. The 

device can send or receive group data to or from multiple 

hosts. 

Advanced Settings Advanced Settings Configuration Bar 

Packing mode Serial port data packaging Ethernet data time, the options 

are as follows: 

 Interval: after sending the last Ethernet packet for some 

time, the system packages the received serial port data 

into Ethernet packets and sends them out; 



 

 

Interface Element Description 

 Forced time: the system packages serial port data 

received within a specified time into Ethernet packets 

and transmit them. 

Packet length The frame length of serial data to Ethernet data. In the set 

time range, the data forwards when it is greater than or 

equals to the set frame length. The value range is 0~1024. It 

means no limit on data transmission length when it’ set to 0. 

Note: 

There are some slight deviations between the actual package 

length value and the set value. 

Delimiter Select the number of delimited characters, the options are as 

follows: 

 Disable: disable delimiter function; 

 1: Enable Delimiter 1 

 2: enable delimiter 2. 

Note: 

If the packaging length or the forced transfer time is 0 and the 

number of delimited character is greater than 0, the system 

would detect and process the delimiter after receiving serial 

data. Every time it receives matched delimiter (or 

combination of characters), the system would send out all 

cached serial data via network. 

Delimiter 1 Delimiter 1, adopts hexadecimal, with a value range of 00-ff. 

Delimiter 2 Delimiter 2, adopts hexadecimal, with a value range of 00-ff. 

Delimiter process Select the delimiter processing method. Options: 

 Retain: the system would send out the received 

delimiter and other data via network. 

 Delimiter+1: the system transfers data after receiving a 

delimiter and an extra byte. 

 Delimiter+2: the system transfers data after receiving a 

delimiter and 2 extra bytes. 

 Delete: the matched delimiter (or combination of 

delimiter) would be deleted. The system only transmits 

data except delimiter. 

Force transmit If the transmission time is greater than 0, the system sends 

the serial data received within the specified time through a 

packet, in the range of 0 to 65535 ms. When the transfer 

time is 0, it means that the data transmission interval is not 

restricted. 



 

 

Interface Element Description 

Apply to all ports Check the “Apply to all port” check box to apply the current 

settings to all serial ports. 

 

5.9 Pair Slave Mode 

 

Pair mode requires two serial server devices to work together to break the serial data 

transmission distance limit. The two serial servers in this mode establish a network 

connection with each other via Ethernet and transparently transmit data from the 

respective serial port to each other. 

In the pair mode, two serial servers need to be used in pairs. One of the serial server for 

the slave mode, for the passive connection, listen to a designated port, passively waiting 

for the connection. Another serial server is the master mode, and the destination 

address is the IP address of the slave mode serial server, the destination port is the 

listening port of the slave mode serial server. 

Interface Description 

Pair Slave Mode interface as follows: 



 

 

 

Pair Slave Mode interface main element configuration instructions: 

Interface Element Description 

Operation mode Operation Mode Configuration Bar 

Serial Num Displays the serial number of the device currently 

configured. 

Operation mode The operation modes of serial port of the device are as 

follows: 

 RealCom Mode 

 Reverse RealCom Mode 

 TCP Server Mode 

 TCP Client Mode 

 UDP Server Mode 

 UDP Client Mode 

 UDP Rang Mode 

 UDP Multicast Mode 

 Pair Slave Mode 

 Pair Master Mode 

 Telnet Mode 

 Reverse Telnet Mode 

 RFC2217 Mode 

 Redundant COM Mode 

 DRDAS RealCom Mode 

 DRDAS TCP Server Mode 



 

 

Interface Element Description 

 Disable Mode 

Pair Slave Mode Pair Slave Mode Configuration Bar 

Port buffering(128K) Port data cache, which can cache serial port data up to 128K 

after the port is disconnected. When the network returns to 

normal, the cached data is forwarded. The tick options are as 

follows: 

 Enable 

 Disable 

Local port Applied to the pair salve mode, that is, the destination port 

of the pair master mode device. 

TCP alive check time The device sends a heartbeat packet by setting the time 

interval. If the device sends a heartbeat packet three times 

without receiving a response, the existing connection is 

disconnected. If set TCP Alive Time to "0", the function will 

be disable. 

Apply to all ports Check the “Apply to all port” check box to apply the current 

settings to all serial ports. 

 

5.10 Pair Master Mode 

Refer to the previous section on Pair Slave Mode. 

Interface Description 

Pair Master Mode interface as follows: 



 

 

 

Pair Master Mode interface main element configuration instructions: 

Interface Element Description 

Operation mode Operation Mode Configuration Bar 

Serial Num Displays the serial number of the device currently 

configured. 

Operation mode The operation modes of serial port of the device are as 

follows: 

 RealCom Mode 

 Reverse RealCom Mode 

 TCP Server Mode 

 TCP Client Mode 

 UDP Server Mode 

 UDP Client Mode 

 UDP Rang Mode 

 UDP Multicast Mode 

 Pair Slave Mode 

 Pair Master Mode 

 Telnet Mode 

 Reverse Telnet Mode 

 RFC2217 Mode 

 Redundant COM Mode 

 DRDAS RealCom Mode 
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 DRDAS TCP Server Mode 

 Disable Mode 

Pair Master Mode Pair Master Mode Configuration Bar 

Port buffering(128K) Port data cache, which can cache serial port data up to 128K 

after the port is disconnected. When the network returns to 

normal, the cached data is forwarded. The tick options are as 

follows: 

 Enable 

 Disable 

TCP alive check time The device sends a heartbeat packet by setting the time 

interval. If the device sends a heartbeat packet three times 

without receiving a response, the existing connection is 

disconnected. If set TCP Alive Time to "0", the function will 

be disable. 

Destination addresses Applied to the pair master mode, that is, the IP address of 

the pair slave mode device. 

Destination port Applied to the pair master mode, that is, the listen port of 

the pair slave mode device. 

Apply to all ports Check the “Apply to all port” check box to apply the current 

settings to all serial ports. 

 



 

 

5.11 Telnet Mode 

 

In Telnet mode, the device can connect serial terminal device and Ethernet transmission 

server device, realizing RS-232 terminal device to access the server through Telnet. The 

Ethernet server device needs to support the Telnet server function, and the device can 

automatically initiate access connection as a Telnet client. After establishing the 

connection, the serial terminal device can communicate with the server directly. 

Interface Description 

The interface of Telnet Mode is as follows: 



 

 

 

Main element configuration instructions in Telnet Mode interface 

Interface Element Description 

Operation mode Operation Mode Configuration Bar 

Serial Num Displays the serial number of the device currently 

configured. 

Operation mode The operation modes of serial port of the device are as 

follows: 

 RealCom Mode 

 Reverse RealCom Mode 

 TCP Server Mode 

 TCP Client Mode 

 UDP Server Mode 

 UDP Client Mode 

 UDP Rang Mode 

 UDP Multicast Mode 

 Pair Slave Mode 

 Pair Master Mode 

 Telnet Mode 

 Reverse Telnet Mode 

 RFC2217 Mode 

 Redundant COM Mode 

 DRDAS RealCom Mode 



 

 

Interface Element Description 

 DRDAS TCP Server Mode 

 Disable Mode 

Telnet Mode RealCom Mode configuration bar 

TCP alive check time The device sends a heartbeat packet by setting the time 

interval. If the device sends a heartbeat packet three times 

without receiving a response, the existing connection is 

disconnected. If set TCP Alive Time to "0", the function will 

be disabled. 

Inactivity time Set the TCP timeout for the serial server's current data 

communication link. 

If the idle time-out during communication is larger than 0, 

the system would close the TCP connection without any data 

transmission activity occurring in the specified time 

automatically. 0 means the free TCP connection would not 

be closed automatically. 

Destination IP 

addresses. 

IP address of the Telnet server device. 

Destination Port The port number of the Telnet server device. The Telnet 

protocol default port is 23. 

Apply to all ports Check the “Apply to all port” check box to apply the current 

settings to all serial ports. 

 



 

 

5.12 Reverse Telnet Mode 

 

In the reverse Telnet mode, opposite to how the Telnet mode works, the device can 

realize Ethernet terminal device to access RS-232 serial port device through Telnet 

mode. The network terminal device initiates access to the device as a Telnet client, and 

the device responds as a Telnet server, and then establishes the connection. 

Interface Description 

Reverse Telnet Mode interface is as follows: 



 

 

 

Reverse Telnet Mode interface main element configuration instructions: 

Interface Element Description 

Operation mode Operation Mode Configuration Bar 

Serial Num Displays the serial number of the device currently 

configured. 

Operation mode The operation modes of serial port of the device are as 

follows: 

 RealCom Mode 

 Reverse RealCom Mode 

 TCP Server Mode 

 TCP Client Mode 

 UDP Server Mode 

 UDP Client Mode 

 UDP Rang Mode 

 UDP Multicast Mode 

 Pair Slave Mode 

 Pair Master Mode 

 Telnet Mode 

 Reverse Telnet Mode 

 RFC2217 Mode 

 Redundant COM Mode 

 DRDAS RealCom Mode 
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 DRDAS TCP Server Mode 

 Disable Mode 

Reverse Telnet Mode Reverse Telnet Mode Configuration Bar 

Max connection The number of host that one serial port connects to. 

 Each host communicates with serial port in the order 

of first-in first-out; 

 The system supports up to 4 connections. 

TCP alive check time The device sends a heartbeat packet by setting the time 

interval. If the device sends a heartbeat packet three times 

without receiving a response, the existing connection is 

disconnected. If set TCP Alive Time to "0", the function will 

be disabled. 

Inactivity time Set the TCP timeout for the serial server's current data 

communication link. 

If the idle time-out during communication is larger than 0, 

the system would close the TCP connection without any 

data transmission activity occurring in the specified time 

automatically. 0 means the free TCP connection would not 

be closed automatically. 

Local listen port The device acts as the local port number used by the Telnet 

server. 

Apply to all ports Check the “Apply to all port” check box to apply the current 

settings to all serial ports. 

 



 

 

5.13 RFC2217 Mode 

 

The RFC2217 mode is similar to the RealCom mode, it defines the COM port control 

options based on the Telnet protocol. In RFC2217 mode, the device supports RFC2217 

protocol specification. The host of network terminal connected by the device can map 

the serial port of the device to the COM port local to the host through installing 

compatible RFC2217 protocol program. In this way, the host can use COM port form to 

realize transparent transmission with the serial port device connected to the device. 

Interface Description 

The interface of RFC2217 Mode is as follows: 



 

 

 

Main element configuration instructions in RFC2217 Mode interface 

Interface Element Description 

Operation mode Operation Mode Configuration Bar 

Serial Num Displays the serial number of the device currently 

configured. 

Operation mode The operation modes of serial port of the device are as 

follows: 

 RealCom Mode 

 Reverse RealCom Mode 

 TCP Server Mode 

 TCP Client Mode 

 UDP Server Mode 

 UDP Client Mode 

 UDP Rang Mode 



 

 

Interface Element Description 

 UDP Multicast Mode 

 Pair Slave Mode 

 Pair Master Mode 

 Telnet Mode 

 Reverse Telnet Mode 

 RFC2217 Mode 

 Redundant COM Mode 

 DRDAS RealCom Mode 

 DRDAS TCP Server Mode 

 Disable Mode 

RFC2217 Mode RFC2217 Mode Configuration Bar 

Max connection The number of host that one serial port connects to. 

 Each host communicates with serial port in the order 

of first-in first-out; 

 The system supports up to 4 connections. 

Local port The device acts as the local port number used by the Telnet 

server. 

TCP alive check time The device sends a heartbeat packet by setting the time 

interval. If the device sends a heartbeat packet three times 

without receiving a response, the existing connection is 

disconnected. If set TCP Alive Time to "0", the function will 

be disabled. 

Advanced Settings Advanced Settings Configuration Bar 

Packing mode Serial port data packaging Ethernet data time, the options 

are as follows: 

 Interval: after sending the last Ethernet packet for 

some time, the system packages the received serial 

port data into Ethernet packets and sends them out; 

 Forced time: the system packages serial port data 

received within a specified time into Ethernet packets 

and transmit them. 

Packet length The frame length of serial data to Ethernet data. In the set 

time range, the data forwards when it is greater than or 

equals to the set frame length. The value range is 0~1024. It 

means no limit on data transmission length when it’ set to 

0. 

Note: 



 

 

Interface Element Description 

There are some slight deviations between the actual package 

length value and the set value. 

Delimiter Select the number of delimited characters, the options are 

as follows: 

 Disable: disable delimiter function; 

 1: Enable Delimiter 1 

 2: enable delimiter 2. 

Note: 

If the packaging length or the forced transfer time is 0 and 

the number of delimited character is greater than 0, the 

system would detect and process the delimiter after 

receiving serial data. Every time it receives matched 

delimiter (or combination of characters), the system would 

send out all cached serial data via network. 

Delimiter 1 Delimiter 1, adopts hexadecimal, with a value range of 00-

ff. 

Delimiter 2 Delimiter 2, adopts hexadecimal, with a value range of 00-

ff. 

Delimiter process Select the delimiter processing method. Options: 

 Retain: the system would send out the received 

delimiter and other data via network. 

 Delimiter+1: the system transfers data after receiving a 

delimiter and an extra byte. 

 Delimiter+2: the system transfers data after receiving a 

delimiter and 2 extra bytes. 

 Delete: the matched delimiter (or combination of 

delimiter) would be deleted. The system only transmits 

data except delimiter. 

Force transmit If the transmission time is greater than 0, the system sends 

the serial data received within the specified time through a 

packet, in the range of 0 to 65535 ms. When the transfer 

time is 0, it means that the data transmission interval is not 

restricted. 

Apply to all ports Check the “Apply to all ports” check box to apply the 

current settings to all serial ports. 

 



 

 

5.14 Redundant COM Mode 

 

Note 

The host needs to install two independent network cards, and the two network cards are in 

different local area networks. 

 

The dual-port serial server accesses two different LANs through two independent ports. 

In Redundant COM mode, the host that has installed COM/TTY driver establishes 2 

transparent or safe network transmission connections between host and serial device 

via dual network port. According to the parameters, such as serial server IP address and 

serial number configured by user, the serial port information of serial server would be 

mapped to the local COM/TTY devices of the host in two ways at the same time. When 

one of the network disconnects, the host still can communicate with serial device 

through another network. 

Interface Description 

Redundant COM Mode interface is as follows: 



 

 

 

Main element configuration description in Redundant Com Mode interface: 

Interface Element Description 

Operation mode Operation Mode Configuration Bar 

Serial Num Displays the serial number of the device currently 

configured. 

Operation mode The working modes of serial port of the device are as 

follows: 

 RealCom Mode 

 Reverse RealCom Mode 

 TCP Server Mode 

 TCP Client Mode 

 UDP Server Mode 

 UDP Client Mode 

 UDP Rang Mode 

 UDP Multicast Mode 

 Pair Slave Mode 
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 Pair Master Mode 

 Telnet Mode 

 Reverse Telnet Mode 

 RFC2217 Mode 

 Redundant COM Mode 

 DRDAS RealCom Mode 

 DRDAS TCP Server Mode 

 Disable Mode 

Redundant COM Mode Redundant  COM Mode Configuration Bar 

TCP alive check time If there isn't any TCP activity within schedule time, the 

system will automatically send connection detection 

message and check whether the TCP connection is valid. 

If the reply packet of opposite side hasn't been received 

after sending probe packet for 3 times, system will regard 

the opposite side as down and forwardly close the 

communication connection. 

Advanced Settings Advanced Settings Configuration Bar 

Packing mode Serial port data packaging Ethernet data time, the 

options are as follows: 

 Interval: after sending the last Ethernet packet for 

some time, the system packages the received serial 

port data into Ethernet packets and sends them out; 

 Forced time: the system packages serial port data 

received within a specified time into Ethernet 

packets and transmit them. 

Packet length The frame length of serial data to Ethernet data. In the 

set time range, the data forwards when it is greater than 

or equals to the set frame length. The value range is 

0~1460. It means no limit on data transmission length 

when it’ set to 0. 

Note: 

There are some slight deviations between the actual 

package length value and the set value. 

Delimiter Select the number of delimited characters, the options 

are as follows: 

 Disable: disable delimiter function; 

 1: Enable Delimiter 1 
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 2: enable delimiter 2. 

Note: 

If the packaging length or the forced transfer time is 0 and 

the number of delimited character is greater than 0, the 

system would detect and process the delimiter after 

receiving serial data. Every time it receives matched 

delimiter (or combination of characters), the system would 

send out all cached serial data via network. 

Delimiter 1 Delimiter 1, adopts hexadecimal, with a value range of 

00-ff. 

Delimiter 2 Delimiter 2, adopts hexadecimal, with a value range of 

00-ff. 

Delimiter process Select the delimiter processing method. Options: 

 Retain: the system would send out the received 

delimiter and other data via network. 

 Delimiter+1: the system transfers data after 

receiving a delimiter and an extra byte. 

 Delimiter+2: the system transfers data after 

receiving a delimiter and 2 extra bytes. 

 Delete: the matched delimiter (or combination of 

delimiter) would be deleted. The system only 

transmits data except delimiter. 

Force transmit If the transmission time is greater than 0, the system 

sends the serial data received within the specified time 

through a packet, in the range of 0 to 65535 ms. When 

the transfer time is 0, it means that the data transmission 

interval is not restricted. 

Apply to all ports Check the “Apply to all ports” check box to apply the 

current settings to all serial ports. 

 



 

 

5.15 DRDAS RealCom Mode 

 

DRDAS（Dual-host Redundant Data Acquisition System）RealCOM mode can 

implement dual-host data collection redundancy backup function. The 2 independent 

network ports of dual-Ethernet port server can access to 2 different local area networks 

and connect to up to 4 remote hosts. Each host that has installed COM/TTY driver could 

create the redundancy backup of RealCOM in 2 local area networks respectively via 

DRDAS RealCOM mode. At this point, the host that serves as the master device and send 

and receive data; while the host that serves as the backup device can receive or monitor 

data, but cannot send data. 

Interface Description 

The interface of DRDAS RealCom Mode is as follows: 



 

 

 

Main element configuration instructions in DRDAS RealCom Mode interface 

Interface Element Description 

Operation mode Operation Mode Configuration Bar 

Serial Num Displays the serial number of the device currently configured. 

Operation mode The operation modes of serial port of the device are as 

follows: 

 RealCom Mode 

 Reverse RealCom Mode 

 TCP Server Mode 

 TCP Client Mode 

 UDP Server Mode 
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 UDP Client Mode 

 UDP Rang Mode 

 UDP Multicast Mode 

 Pair Slave Mode 

 Pair Master Mode 

 Telnet Mode 

 Reverse Telnet Mode 

 RFC2217 Mode 

 Redundant COM Mode 

 DRDAS RealCom Mode 

 DRDAS TCP Server Mode 

 Disable Mode 

DRDAS RealCom 

Mode 

DRDAS RealCom Mode configuration bar 

TCP alive check time If there isn't any TCP activity within schedule time, the system 

will automatically send connection detection message and 

check whether the TCP connection is valid. If the reply packet 

of opposite side hasn't been received after sending probe 

packet for 3 times, system will regard the opposite side as 

down and forwardly close the communication connection. 

Primary IP address The IP address of remote host that establishes RealCOM 

connection with the device can send and receive device’s 

data. 

Backup IP Address 1 The IP address of remote backup host 1 that establishes 

RealCOM connection with the device can only receive device’s 

data but not send data to it. 

Backup IP Address 2 The IP address of remote backup host 2 that establishes 

RealCOM connection with the device can only receive device’s 

data but not send data to it. 

Backup IP Address 3 The IP address of remote backup host 3 that establishes 

RealCOM connection with the device can only receive device’s 

data but not send data to it. 

Advanced Settings Advanced Settings Configuration Bar 

Packing mode Serial port data packaging Ethernet data time, the options are 

as follows: 
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 Interval: after sending the last Ethernet packet for some 

time, the system packages the received serial port data 

into Ethernet packets and sends them out; 

 Forced time: the system packages serial port data 

received within a specified time into Ethernet packets and 

transmit them. 

Packet length The frame length of serial data to Ethernet data. In the set 

time range, the data forwards when it is greater than or 

equals to the set frame length. The value range is 0~1460. It 

means no limit on data transmission length when it’ set to 0. 

Note: 

There are some slight deviations between the actual package 

length value and the set value. 

Delimiter Select the number of delimited characters, the options are as 

follows: 

 Disable: disable delimiter function; 

 1: Enable Delimiter 1 

 2: enable delimiter 2. 

Note: 

If the packaging length or the forced transfer time is 0 and the 

number of delimited character is greater than 0, the system 

would detect and process the delimiter after receiving serial 

data. Every time it receives matched delimiter (or combination 

of characters), the system would send out all cached serial data 

via network. 

Delimiter 1 Delimiter 1, adopts hexadecimal, with a value range of 00-ff. 

Delimiter 2 Delimiter 2, adopts hexadecimal, with a value range of 00-ff. 

Delimiter process Select the delimiter processing method. Options: 

 Retain: the system would send out the received delimiter 

and other data via network. 

 Delimiter+1: the system transfers data after receiving a 

delimiter and an extra byte. 

 Delimiter+2: the system transfers data after receiving a 

delimiter and 2 extra bytes. 

 Delete: the matched delimiter (or combination of 

delimiter) would be deleted. The system only transmits 

data except delimiter. 

Force transmit If the transmission time is greater than 0, the system sends 

the serial data received within the specified time through a 
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packet, in the range of 0 to 65535 ms. When the transfer time 

is 0, it means that the data transmission interval is not 

restricted. 

Apply to all ports Check the “Apply to all ports” check box to apply the current 

settings to all serial ports. 

 

5.16 DRDAS TCP Server Mode 

 

DRDAS (Dual-host Redundant Data Acquisition System) TCP Server mode can implement 

dual-host data collection redundancy backup function. The 2 independent network ports 

of dual-Ethernet port server can access to 2 different local area networks and connect to 

up to 4 remote hosts. Each host create the redundancy backup of TCP Socket in 2 local 

area networks respectively via DRDAS TCP Server mode. At this point, serial server is as 

TCP server and host is as TCP client. The host that serves as the master device can send 

and receive data; while the host that serves as the backup device can receive or monitor 

data, but cannot send data. 

Interface Description 

DRDAS TCP Server Mode interface as follows: 



 

 

 

The main element configuration description of DRDAS TCP Server Mode interface: 

Interface Element Description 

Operation mode Operation Mode Configuration Bar 

Serial Num Displays the serial number of the device currently configured. 

Operation mode The operation modes of serial port of the device are as follows: 

 RealCom Mode 

 Reverse RealCom Mode 

 TCP Server Mode 

 TCP Client Mode 

 UDP Server Mode 
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 UDP Client Mode 

 UDP Rang Mode 

 UDP Multicast Mode 

 Pair Slave Mode 

 Pair Master Mode 

 Telnet Mode 

 Reverse Telnet Mode 

 RFC2217 Mode 

 Redundant COM Mode 

 DRDAS RealCom Mode 

 DRDAS TCP Server Mode 

 Disable Mode 

DRDAS TCP Server 

Mode 

DRDAS TCP Server Mode Configuration bar 

TCP alive check 

time 

If there isn't any TCP activity within schedule time, the system 

will automatically send connection detection message and 

check whether the TCP connection is valid. If the reply packet of 

opposite side hasn't been received after sending probe packet 

for 3 times, system will regard the opposite side as down and 

forwardly close the communication connection. 

Primary IP Address The IP address of remote host that establishes TCP connection 

with the device can send and receive device’s data. 

Backup IP Address 

1 

The IP address of remote backup host 1 that establishes TCP 

connection with the device can only receive device’s data but 

not send data to it. 

Backup IP Address 

2 

The IP address of remote backup host 2 that establishes TCP 

connection with the device can only receive device’s data but 

not send data to it. 

Backup IP Address 

3 

The IP address of remote backup host 3 that establishes TCP 

connection with the device can only receive device’s data but 

not send data to it. 

Local port The destination connection port of TCP client. 

Advanced Settings Advanced Settings Configuration Bar 

Packing mode Serial port data packaging Ethernet data time, the options are 

as follows: 
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 Interval: after sending the last Ethernet packet for some 

time, the system packages the received serial port data 

into Ethernet packets and sends them out; 

 Forced time: the system packages serial port data received 

within a specified time into Ethernet packets and transmit 

them. 

Packet length The frame length of serial data to Ethernet data. In the set time 

range, the data forwards when it is greater than or equals to 

the set frame length. The value range is 0~1460. It means no 

limit on data transmission length when it’ set to 0. 

Note: 

There are some slight deviations between the actual package 

length value and the set value. 

Delimiter Select the number of delimited characters, the options are as 

follows: 

 Disable: disable delimiter function; 

 1: Enable Delimiter 1 

 2: enable delimiter 2. 

Note: 

If the packaging length or the forced transfer time is 0 and the 

number of delimited character is greater than 0, the system 

would detect and process the delimiter after receiving serial data. 

Every time it receives matched delimiter (or combination of 

characters), the system would send out all cached serial data via 

network. 

Delimiter 1 Delimiter 1, adopts hexadecimal, with a value range of 00-ff. 

Delimiter 2 Delimiter 2, adopts hexadecimal, with a value range of 00-ff. 

Delimiter process Select the delimiter processing method. Options: 

 Retain: the system would send out the received delimiter 

and other data via network. 

 Delimiter+1: the system transfers data after receiving a 

delimiter and an extra byte. 

 Delimiter+2: the system transfers data after receiving a 

delimiter and 2 extra bytes. 

 Delete: the matched delimiter (or combination of 

delimiter) would be deleted. The system only transmits 

data except delimiter. 

Force transmit If the transmission time is greater than 0, the system sends the 

serial data received within the specified time through a packet, 
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in the range of 0 to 65535 ms. When the transfer time is 0, it 

means that the data transmission interval is not restricted. 

Apply to all ports Check the “Apply to all port” check box to apply the current 

settings to all serial ports. 

 

5.17 Disable Mode 

In Disable Mode, the serial port will be closed and cannot be used normally. 

Interface Description 

The interface of Disable Mode is as follows: 

 

Main element configuration instructions in Disable Mode interface 

Interface Element Description 

Operation mode Operation Mode Configuration Bar 

Serial Num Displays the serial number of the device currently 

configured. 

Operation mode The operation modes of serial port of the device are as 

follows: 

 RealCom Mode 

 Reverse RealCom Mode 

 TCP Server Mode 

 TCP Client Mode 

 UDP Server Mode 

 UDP Client Mode 

 UDP Rang Mode 



 

 

Interface Element Description 

 UDP Multicast Mode 

 Pair Slave Mode 

 Pair Master Mode 

 Telnet Mode 

 Reverse Telnet Mode 

 RFC2217 Mode 

 Redundant COM Mode 

 DRDAS RealCom Mode 

 DRDAS TCP Server Mode 

 Disable Mode 

Apply to all ports Check the “Apply to all ports” check box to apply the current 

settings to all serial ports. 

 



 

 

6 Serial Port Status 

Function Description 

On the "Serial Port Status" page, you can view the statistics of the number of bytes 

received and sent during the conversion between the corresponding serial port and the 

network. 

Operation Path 

Open: "Serial Port Status". 

Interface Description 

Serial Port Status interface is as follows: 



 

 

 

Serial Port Status interface main element configuration description: 

Interface Element Description 

Serial Num Display corresponding device serial port. 

Net receive Number of bytes received by the device network interface. 

Net send Number of bytes sent by the device network interface. 

Uart receive Number of bytes received by the serial port of the device. 

Uart send Number of bytes sent by serial port of device. 



 

 

7 SNMP 

SNMP (Simple Network Management Protocol) is a network management standard 

protocol widely used in TCP/IP networks. SNMP provides a way to manage devices by 

running network management software on a central computer (or network 

management workstation). 

SNMP System consists of NMS (Network Management System), Agent Process, 

Management Object and MIB (Management Information Base) four parts. Agent: Agent 

is an agent process in the managed device, which is used to maintain the information 

data of the managed device and respond to the request from the NMS, and report the 

administration data to the NMS that sending the request. 

7.1 SNMP Agent Settings 

Function Description 

On the "SNMP Agent Settings" page, the SNMP function can be enabled and disabled, 

and other related parameters such as SNMP community name, version and user 

information can be configured. 

Operation Path 

Open in order: "SNMP > SNMP Agent Settings". 

Interface Description 

SNMP Agent Settings interface is as below: 



 

 

 

Main element configuration description of SNMP Agent Settings configuration interface: 

Interface Element Description 

SNMP The radio box of enable/disable SNMP function, the 

options are as follows: 

 Enable 

 Disable 

Read community string The text box of readable community name, supporting 

0-32-bit character string input. The readable 

community name is used for authentication of Get 

operation between Agent and NMS. 

Write community string The text box of writeable community name, 

supporting 0-32-bit character string input. The 

writeable community name is used to complete Set 

operation authentication between Agent and NMS. 

Contact name The text box of SNMP contact information, which 

supports 0-32-bit character string input. 



 

 

Interface Element Description 

Location The text box of position information, which supports 

0-32-bit character string input. 

SNMP agent version The check box of the SNMP agent version, which 

supports optional v1, v2 and v3 versions. Compared 

with v1/v2, version v3 mainly adds authentication and 

encryption. 

Read only user name The text box of read-only user name, supporting 0-32-

bit character string input. 

Read only authentication 

mode 

The drop-down list of read-only user authentication 

mode, the options are as follows: 

 Disable 

 MD5: message digest algorithm 5; 

 SHA: Secure Hash Standard. 

Read only password The text box of read-only user authentication key, 

supporting 0-32-bit character string input. 

Read only privacy mode The drop-down list of read-only user data encryption 

mode, the options are as follows: 

 Disable 

 DES_CBC: The system encrypts the data by using 

the cipher group link code of the data encryption 

standard. 

Read only privacy Read-only user data encryption key text box, 

supporting 0-32 bit character string input. 

Read/write user name The text box of read/write user name, supporting 0-32 

bit character string input. 

Read/write authentication 

mode 

The drop-down list of read/write user authentication 

mode, the options are as follows: 

 Disable 

 MD5 (message digest algorithm 5); 

 SHA: Secure Hash Standard. 

Read/write password The text box of read/write user authentication key, 

supporting 0-32-bit character string input. 

Read/write privacy mode The drop-down list of read/write user data encryption 

mode, the options are as follows: 

 Disable 



 

 

Interface Element Description 

 DES_CBC: The system encrypts the data by using 

the cipher group link code of the data encryption 

standard. 

Read/write privacy The text box of read/write user data encryption key, 

supporting 0-32-bit character string input. 

 



 

 

8 Alert Setting 

8.1 Email Alert 

Function Description 

On the "Email Alert" page, users can configure parameters such as mail sender, recipient 

and mailbox server. The system can inform the change information of power 

connection, warm start, cold start, LAN port connection, serial DCD and DSR signals of 

the device by mail. 

Operation Path 

Open in order: "Alert Setting > Email Alert". 

Interface Description 

The Email Alert setting interface is as follows: 

 

Main element configuration description of Email Alert configuration interface: 



 

 

Interface Element Description 

Mail Server (SMTP) Mailbox server address using SMTP simple mail transfer 

protocol provided by mailbox service provider, and mailbox 

server address used by sender when sending mail. 

Port numbers Port number of mailbox server. 

Auth type The drop-down list of authentication method, the options 

are as follows: 

 Plaintext; 

 SSL: encryption protocol of Secure Sockets Layer; 

 TLS: encryption protocol of Transport Layer Security. 

My server requires 

authentication 

The check box of mailbox server authentication. Check the 

configuration according to the authentication requirements 

of mailbox server. 

User name The user name of the sender's mailbox server. 

Password Login password or authorization code of sender's mailbox 

server. 

From e-mail address The email address from which the sender sends a warning 

message. 

To e-mail address 1 The input text box of Address 1 , which is used to fill in the 

email address of receiving alarm mails. 

To e-mail address 2 The input text box of Address 2 , which is used to fill in the 

email address of receiving alarm mails. 

To e-mail address 3 The input text box of Address 3 , which is used to fill in the 

email address of receiving alarm mails. 

To e-mail address 4 The input text box of Address 4 , which is used to fill in the 

email address of receiving alarm mails. 

 

8.2 SNMP Trap 

Function Description 

On the SNMP Trap page, you can configure the IP address or domain name of the server 

that receives SNMP Trap information. 

Operation Path 

Open in order: "Alert Setting > SNMP Trap". 



 

 

Interface Description 

The SNMP Trap settings interface as follows: 

 

Main element configuration description of Email Alert configuration interface: 

Interface Element Description 

SNMP trap server ip or 

domain name 

The text box of IP address or domain name of SNMP Trap 

server. The server is used to receive SNMP Trap information 

sent by devices. 

Trap version The radio box of SNMP Trap version, which supports 

optional v1 and v2c versions. 

Trap community The text box of SNMP Trap community name, which 

specifies SNMP community name. 

 

8.3 Event Settings 

Function Description 

On the "Event Settings" page, you can configure the alarm mode of system events and 

serial port alarms. 

Operation Path 

Open in order: "Alert Setting > Event Settings”. 

Interface Description 

The Event Settings interface is as below: 



 

 

 



 

 

 



 

 

Main elements configuration descriptions of Event Settings interface: 

Interface Element Description 

System event alert System event alert configuration bar 

Event System event alert types, shown as follows: 

 Power 1 down 

 Power 2 down 

 Cold start: device starts when power off; 

 Warm start: restart the device when there has power 

connection; 

 Ethernet 1 link down 

 Ethernet 2 link down 

 Console(web/text) login auth fail 

 IP changed 

 Password changed 

 Time synchronization 

 Ntp connection failure 

 E-mail sending failure 

 Firmware upgrade 

 Configuration changed 

 Configuration import 

 Configuration export 

 Network connection of serial port mode 

 Network disconnection of serial port mode 

System alert System alert mode check box, the options are as follows: 

 trap: SNMP trap alert. 

 Mail: Mail Alarm 

 Syslog: Log Alert 

Port Alarm Settings Port Alarm Settings Configuration Bar 

Serial port No. serial number corresponding to the serial port of device. 

DCD change The state change alert of DCD data carrier monitoring signal of 

serial port, indicating that the connection state of serial port 

device on the other end has changed. If DCD becomes low, the 

serial port connection may be disconnected. Alert mode check 

box, the options are as follows: 

 trap: SNMP trap alert; 

 mail: mail alarm. 

DSR change The DSR data of the serial port is ready for signal state change 

alert, indicating that the serial port device on the end without 



 

 

Interface Element Description 

power supply. If the DSR becomes low, the serial port device 

will lose power supply. Alert mode check box, the options are 

as follows: 

 trap: SNMP trap alert; 

 mail: mail alarm. 

 



 

 

9 System Manage 

9.1 Device Information 

Function Description 

On the “Device Information” page, users can configure the device name, device 

description, and maintenance contact information. 

Operation Path 

Open in order: "System Manage > Device Information". 

Interface Description 

Screenshot of Device Information interface: 

 

Main element configuration description of Device Information interface: 

Interface Element Description 

Device model Device model information, the input box is grayed and cannot 

be entered by default. 

Device name Enter the device name in the “Name” text box. To identify each 

device in the network, give the device a different name. 

Description Enter the device description in the “Description” text box. 

Serial no. Device serial information, the input box is grayed and cannot 

be entered by default. 



 

 

Interface Element Description 

Contact  Enter the contact information of the equipment maintenance 

personnel in the "Contact" text box. 

 

9.2 Time Setting 

The full name of NTP protocol is Network Time Protocol. Its purpose is to deliver 

uniform, standardized time on the Internet. The specific implementation solution is to 

specify several clock source websites on the network to provide time service for users, 

and these websites should be able to compare with each other to improve accuracy. It 

can provide millisecond time correction, and is confirmed by the encrypted way to 

prevent malicious protocol attacks. 

Function Description 

On the "Time Setting" page, users can configure the device time and NTP server 

information. 

Operation Path 

Open in order: "System Manage > Time Setting". 

Interface Description 

The Time Setting interface as below: 

 

Main elements configuration descriptions of Time Setting interface: 

Interface Element Description 

Time zone Time standard of different global regions. 

Local time The device's own time. Click the "Change" button to manually 

modify the device time or synchronize it to the current 

computer time. 



 

 

Interface Element Description 

Time server IP address or domain name of NTP server. The device will 

automatically synchronize NTP server time. 

 

9.3 Remote Administration 

HTTPS (Full name: Hypertext Transfer Protocol over Secure Socket Layer), is the HTTP 

channel which takes safety as the goal, is a safe version of HTTP. HTTPS provides data 

encryption services that prevent attackers from intercepting transmission messages 

between Web browsers and Web servers to steal sensitive information such as credit 

card Numbers, passwords, and so on. 

The full English name of SSH is Secure Shell. SSH is the security protocol based on the 

application layer and transport layer. Telnet is transmitted in plaintext, while SSH is 

transmitted in ciphertext, which is more secure. SSH is a currently reliable protocol that 

provides security protocol for remote login sessions and other web services. SSH 

protocol can effectively prevent the information leakage in the process of remote 

management issues, and DNS and IP spoofing. In addition, the transmitted data is 

compressed so that the transmission speed can be increased. 

Function Description 

On the "Remote Administration" page, access methods such as TELNET, HTTP, HTTPS 

and SSHD can be restricted. 

Operation Path 

Open in order: "System Manage > Remote Administration". 

Interface Description 

The Remote Administration interface is as follows: 

 



 

 

Main element configuration description of Remote Administration interface: 

Interface Element Description 

TELNET Service TELNET service function status, the options are as follows: 

 Enable; 

 Disable 

Note: 

When enabled, the TELNET client can access the CLI interface 

of the device. 

HTTP Device HTTP protocol function status, options are as follows: 

 Enable; 

 Disable 

Note: 

When enabled, when using HTTP to access the WEB interface, 

the format is HTTP://192.168.1.254, and the address is the IP 

address of the corresponding device. 

HTTPS Device HTTPS protocol function status, options are as follows: 

 Enable; 

 Disable 

Note: 

When enabled, when using HTTPS to access the WEB 

interface, the format is HTTPS://192.168.1.254, and the address 

is the IP address of the corresponding device. 

SSHD Service SSH service function status, the options are as follows: 

 Enable; 

 Disable 

Note: 

When enabled, the SSH client can access the CLI interface of 

the device. 

 

9.4 User Management 

Function Description 

On the "User Management" page, users can add and delete users freely. Users need to 

access the device by logging in with user name and password. The initial user name and 

password are admin. 

Operation Path 

Open in order: "System Manage > User Management". 



 

 

Interface Description 

The User Management interface is as follows: 

 

Main element configuration description of User Management interface: 

Interface Element Description 

User name Identification of the visitor. 

Note: 

User names and passwords can support up to 32 characters. 

Privilege The user's access rights are shown as follows: 

 Administrator: has administrator authority and can 

configure parameters of device; 

 General user: has viewing authority, and can view device 

configuration parameters and network diagnosis 

operations. 

Operate Click Edit to modify the password and user rights of the current 

user. 

 

9.5 IP Address Filtering 

Function Description 

Users can limit the ongoing access or connected host IP address and subnet mask via 

setting access rules on the " IP Address Filtering " page. 

Operation Path 

Open in order: "System Manage > IP Address Filtering". 

Interface Description 

The IP Address Filtering interface as follows: 



 

 

 

IP filter interface main element configuration instructions 

Interface Element Description 

IP Address Filtering Enable or disable IP filtering rules. 

 Enable 

 Disable 

Operation mode Set filtering rules for IP addresses. 

 White list: the IP address set in the filtering rule is allowed 

to access the device. 

 Blacklist: IP addresses set in filtering rules are prohibited 

from accessing devices. 

Notice: 

 When the white list is enabled, IP addresses outside the 

white list will not be able to access the device. 

 If the IP address in the white list cannot access the device, 

please clean the browser cache and access it again. 



 

 

Interface Element Description 

 When the blacklist is enabled, the IP addresses covered by 

the blacklist will not be able to access the device. 

Number Displays the IP address filtering rule number. 

Status Enable or disable filtering rules. 

 Enable 

 Disable 

IP Address Set the IP address in dotted decimal format in the filter rule, 

such as "192.168.1.61". 

Subnet mask Set the subnet mask in dotted decimal format in the filter rule, 

such as "255.255.255.0". 

 

9.6 Mac Address Filtering 

Function Description 

On the " Address Filtering " page, user can restrict the host MAC address to access or 

connect by setting access rules. 

Operation Path 

Open in order: "System Manage > MAC Address Filtering". 

Interface Description 

MAC Address Filtering interface shown as follows: 



 

 

 

Main element configuration description in MAC Address Filtering interface: 

Interface Element Description 

MAC address 

filtering 

Enables or disables MAC address filtering rules. 

 Enable 

 Disable 

Operation mode Set filtering rules for IP addresses. 

 White list: the MAC address set in the filtering rule is 

allowed to access the device. 

 Blacklist: MAC addresses set in filtering rules are 

prohibited from accessing devices. 

Notice: 

 When the white list is enabled, MAC addresses outside the 

white list will not be able to access the device. 

 When the blacklist is enabled, the MAC addresses covered 

by the blacklist will not be able to access the device. 



 

 

Interface Element Description 

Number Display the MAC address filtering rule number. 

Status Enable or disable filtering rules. 

 Enable 

 Disable 

MAC Address Set the six-byte hexadecimal format MAC address in the filter 

rule, such as "00-22-6F-03-BD-52". 

 

9.7 System Log 

Function Description 

On the "System log" page, you can view the log information of the device and upload 

the log information to the syslog server. During the operation of the device, the system 

will record all kinds of situations in operation, thus forming log information. The log 

information is mainly used to check the running status of device, analyze the status of 

network and locate the causes of problems, and provide basis for system diagnosis and 

maintenance. The generated log information can be saved on the device, and the log 

information can be output to the log server by using syslog protocol. 

Operation Path 

Open in order: "System Manage > System log". 

Interface Description 

The System log interface is as follows: 



 

 

 

Main element configuration description of System log interface: 

Interface Element Description 

Model System log server configuration type, which can be checked as 

follows: 

 Enable: when enabled, the system log will be saved to the 

remote system log server. 

 Disable: Disable the syslog server function. 

Message type System log information transmission protocol, which can be 

selected as follows: 

 TCP: system log information is sent to the log server by 

TCP protocol. TCP (transmission control protocol), 

connection-oriented and reliable transmission-layer 

communication protocol; 

 UDP: the system log information is sent to the log server 

by UDP protocol. UDP (user datagram protocol), 

connectionless-oriented transmission-layer 

communication protocol. 



 

 

Interface Element Description 

IP IP address of the syslog server. 

Port The port number of syslog server, and the default port of 

syslog protocol is 514. 

Syslog severity The level of system log can be selected as follows: 

 LOG_EMERG: extremely urgent error; 

 LOG_ALERT: an error that needs to be corrected 

immediately; 

 LOG_CRIT: a more serious error; 

 LOG_ERR: An error occurred; 

 LOG_WARNING: warning, there may be some error; 

 LOG_NOTICE: information to be noticed; 

 LOG_INFO: general prompt information; 

 LOG_DEBUG: debug information. 

 

Configuration Instance 

"Visual Syslog Server" is a free open source software for receiving and viewing syslog 

messages. At present, the host with "Visual Syslog Server" installed is used as the system 

log server, and the IP address of the host is 192.168.1.101. The device transmits log 

information to the host server through TCP protocol. The configuration steps are as 

follows: 

Step 1 Log in to the device WEB interface. 

Step 2 On the "System log" page, configure relevant parameters, as shown in the following 

figure: 

 

1 In the "Model" option, check "enable"; 

2 In the Message type option, check the TCP protocol; 



 

 

3 In the IP text box, enter the IP address "192.168.1.101" of the server. 

4 In the "Port" text box, enter the port number of the server, and the default port of 

syslog protocol is 514; 

5 In the Syslog severity drop-down list, select log _ info; 

6 Click the Submit button. 

Step 3 Run "Visual Syslog Server" on the host to complete the configuration of relevant 

parameters, as shown below. 

 

1 Click the "Setup" button, as shown in the above figure; 



 

 

 

2 On the "Setup" page, in the Main configuration area, check "Enable TCP Listener", 

as shown in the above figure; 

3 Select the IP address "192.168.1.101" and port number "514" of the server from the 

"TCP listener interface and port" drop-down list; 

4 Click “OK”. 

Step 4 Check the log information in the "Visual Syslog Server" configuration interface, as shown 

in the following figure. 

 



 

 

Step 5 End. 

9.8 ARP Settings 

Free ARP function can prevent communication interrupt caused by the switch and 

router aging the MAC address of serial server. 

Function Description 

On the ARP Settings page, the gratuitous ARP function could be enabled and the 

parameter of send period could be set. 

Operation Path 

Open in order “System Manage > ARP Settings”. 

Interface Description 

ARP Settings interface as follows: 

 

The ARP Settings interface main element configuration instructions: 

Interface Elements Description 

Gratuitous ARP Gratuitous ARP function state, options as follows: 

 Enable 

 Disable 

Send period Interval of sending Gratuitous ARP network packet, default 

to 10, for instance: 10-1000s 

 



 

 

9.9 Diagnostic Test 

9.9.1 Ping 

Function Description 

On the "Ping" page, users can use the Ping command to check whether the network is 

clear or the network connection speed. The Ping command uses the uniqueness of the 

IP address   on the network to send a packet to the target IP address, and then asks to 

return a packet of the same size to determine whether the network is connected and 

what the delay is. 

Operation Path 

Open in order: "System Manage > Diagnosis > Ping". 

Interface Description 

Ping information interface as follows: 

 

Main element configuration instructions in Ping interface: 

Interface Element Description 

IP address The IP address of the detected device, that is, the destination 

address. The device can check the network intercommunity to 

other devices via the ping command. 

 

Ping Configuration 

Step 1 Fill in the IP address that needs ping in the IP address text box; 

Step 2 Click the "Start" to see the Ping results; 



 

 

 

Step 3 End. 

9.9.2 Traceroute 

Function Description 

On the "Traceroute" page, users can test the network conditions between the device 

and the target host. Traceroute measures how long it takes by sending small packets to 

the destination device until they return. Each device on a path Traceroute returns three 

test results. The output includes the time of each test (ms), the name of the device (if 

any), and its IP address. 

Operation Path 

Open in order: "System Manage > Diagnosis > Traceroute". 

Interface Description 

TRACEROUTE interface as follows: 

 

Main element configuration instructions in TRACEROUTE interface: 

Interface Element Description 

IP address IP address of the destination device, fill in the IP address of the 

opposite device that needs to be detected. 



 

 

 

TRACEROUTE Configuration 

Step 1 Fill in the IP address in the IP address text box. 

Step 2 Click the "Start" to see the results, as the picture below. 

 

Note: 

The above figure shows the time from the device to IP address 192.168.1.110, which 

takes 0.652ms after one hop. 

Step 3 End. 

9.10 System Maintenance 

9.10.1 Configuration File Management 

Function Description 

On the "Management File" page, user can download and upload configuration file. 

Operation Path 

Open in order: "System Manage > System Management > Configuration File". 

Interface Description 

Management file interface as follows: 

 



 

 

Configuration file management interface Main element configuration instructions 

Interface Element Description 

Save IP 

configuration 

When checked, the device can keep the current IP address 

after importing the configuration file. 

Select file Select the path to upload the configuration file locally, and click 

Browse to select the required configuration file. 

Note: 

Uploaded configuration files need to be exported by devices of 

the same model. 

Download Download the configuration file of the current device in the 

format of. Tar. 

Note: 

The downloaded configuration file will be saved in the format 

of ".tar", which is encrypted, so please do not decompress or 

modify it. 

Upload Upload configuration file 

 

Note 
 After finishing update, the device will automatically open a new page to "System 

State", and uploading configuration file will be valid after the device is reset. 
 After uploading the configuration file, if the static IP in the configuration file and the 

computer IP are not in the same network segment, the webpage cannot be opened. 
 While uploading configuration file, if dynamic IP is used in the configuration file 

and there is no DHCP server in the network segment, relative IP portion won't be 

updated. 
 Do not click on or configure other WEB pages of the device or restart the device 

when uploading configuration files or upgrading software. Otherwise, the 

configuration file upload or software update will fail, or the device system will crash. 

 

9.10.2 Restore Factory Settings 

Function Description 

On the "Restore Factory Settings" page, user can restore the device to default setting. 

Operation Path 

Open in order: "System Manage > System Management > Restore". 

Interface Description 

Restore Factory Settings interface is as follows: 



 

 

 

Main element configuration instructions in Restore Factory settings interface: 

Interface Element Description 

Save IP 

configuration 

When checked, the device can keep the current IP address 

after restoring the factory settings. 

Restore Click this button and the device will lose all existing 

configurations and reverts to factory settings. 

 

Note 

Restoring factory value settings will cause all configurations to be in the factory state, 

where the IP address is the static IP address "192.168.1.254", and the user name and 

password default to "admin". 

 

9.10.3 Online Update 

Function Description 

On the Online Upgrade page, you can update and upgrade the device program. 

Operation Path 

Open in order: "System Manage > System Management > software Upgrade". 

Interface Description 

Online Update interface is as follows: 



 

 

 

Main element configuration instructions in Online Update interface: 

Interface Element Description 

Restore When checked, the device will be restored to the factory 

settings after upgrading. After unchecking, the 

configuration parameters will be kept after the device 

software is upgraded. 

Save IP configuration After the software upgrade is checked to restore the 

factory configuration, the IP configuration can be checked 

to keep the current IP address and other parameters will be 

restored to the factory configuration. 

Select file Select the path of the local upgrade file, and click Browse to 

select the required configuration file. 

Upgrade Click the upgrade button to start the program upgrade. 

 

Note 
 Do not click on or configure other WEB pages of the device or restart the device or 

power off the device when upgrading software. Otherwise, the software update will 

fail, or the device system will crash. 
 Maintain a reliable wired connection when upgrading. 
 When the online upgrade is complete, the device will restart automatically. 

 



 

 

10 Work Mode Configuration Instance 

10.1 RealCom Mode 

Background Introduction 

Assume that the IP address of the serial server is: 192.168.1.250; COM1 is a real serial 

port, need to establish a connection with the virtual serial port COM2 in the 

management software VSP Manager. 

The serial port information is as follows: 

 Baud rate: 115200 

 Parity bit: None 

 Data bit: 8 

 Stop bit: 1 

Operation Steps 

Step 1 Configure the IP address of the serial server. 

1. Log in to the Web configuration interface and select "Network Configuration”. 

2. In the "LAN1" option box, enter the "LAN1 IP address", "LAN1 Subnet Mask" and 

"LAN1 Gateway " corresponding to the serial server. 

3. Other parameters remain the default, click "Submit". 



 

 

 

Step 2 Configure the serial port parameter information. 

1. Log in to the Web configuration interface and select "Communication Parameters". 

2. In the serial port 1 entry, click "Edit". 

 

3. Set the “Baud Rate”, “Data Bits”, “Stop Bits” and “Parity” in the pop-up box. 



 

 

 

4. Other parameters remain the default, click "Submit". 

Step 3 Configure the working mode of the serial server. 

1. Log in to the Web configuration interface and select "Operation Modes > Port1”. 

 



 

 

2. Click the "Operation Mode" drop-down list box and select "RealCom Mode". 

3. Click “Max connection” drop-down list box, and select “1 “. 

4. Other parameters remain the default, click "Submit". 

Step 4 Run "VSP Manager" software, configure the virtual serial port COM2. 

1. Run the virtual serial port management software "VSP Manager", click "Manual 

Device" in the left navigation bar, and select "Add Device". Enter the IP address and 

subnet mask of the serial server and click “OK”. 

 

2. Right click "192.168.1.250" and select "Add Port". After creating the virtual serial port 

COM2, click “OK”. 

 



 

 

3. Double-click the created virtual serial port "COM2". Click "Base" in the “COM2 

Properties” option box, configure the virtual serial port COM2 parameter information 

and real COM1 match the same. 

 

After the completion of the above configuration, between the real serial port COM1 and 

virtual COM2 connection can be successfully established to send data to each other. 

Step 5 Run "ComTest" software to test the communication between real serial port COM1 and 

virtual serial port COM2. 

1. Install and run the ComTest, and click “Begin > New Windows” in the start menu. 

2. Add the real serial "COM1" and virtual serial "COM2" two windows, the "COM1" and 

"COM2" serial port parameter information match. 

 



 

 

3. Open “COM1” and “COM2” serial signal respectively, check “Manual send” checkbox, 

test and check the data transmission status between real serial port COM1 and 

virtual serial port COM2. 

 

 



 

 

10.2 Reverse RealCom Mode 

Background Introduction 

Assume that the IP address of the serial server needs to be automatically assigned by 

DHCP or BOOTP, and the host manages the serial terminal device through the serial 

server. Now connect the host's own RS-232 serial port, COM1, to the Port1 of the serial 

server, and install ComTest software to simulate the serial terminal device. At the same 

time, the host computer installs VSP software, maps the serial port terminal device 

connected to the serial port server Port1 to the local COM2 of the host computer, and 

simulates the management terminal by ComTest software. When the IP address of the 

serial server changes, the communication between the management terminal (COM2) 

and the terminal (COM1) can still be normal. 

Parameter information of serial terminal is as follows: 

 Baud rate: 115200 

 Parity bit: None 

 Data bit: 8 

 Stop bit: 1 

Host parameter information as follow: 

 IP address: 192.168.1.61 

 Data port: 33000 

 Command port: 34000 

The parameters of the serial server are as follows: 

 IP address: DHCP (assuming that the automatically acquired IP address is 

192.168.1.250) 

 Communication parameters: Port1 is consistent with serial terminal parameters 

 Working mode: Reverse RealCom Mode 

Operation steps 

Step 1 Configure the communication parameter information of serial server. 

1. Log in to the WEB configuration interface and select "Communication Parameters". 

2. In the Port1 entry, click Edit under operation, as shown in the following figure. 



 

 

 

3. In the serial port parameter option box, set "Baud Rate", "Parity", "Data Bits", "Stop 

Bits" and "interface" parameters respectively, as shown in the following figure. 

 

4. Other parameters remain the default, click “Submit”. 

Step 2 Configure the working mode of the serial server, as shown in the following figure. 



 

 

 

1 Log in to the WEB configuration interface and select "Operation Modes > Port1". 

2 Click the "Operation mode" drop-down list and select "Reverse RealCom Mode". 

3 In the "Destination address1" text box, enter the IP address of the host 

"192.168.1.61". 

4 Enter the data port "33000" in the "Destination tcp port" text box of address 1. 

5 Enter the Command port "34000" in the "Destination tcp port" text box of address 

1. 

6 Other parameters remain the default, click “Submit”. 

Step 3 Run "VSP Manager" software, configure the virtual serial port COM2. 

1 Install and run the "VSP Manager" software on the host, and refer to the VSP user 

manual for the installation process. 

2 On the menu bar, click View > VSP Service Properties, and then click the Advance 

tab. 

3 In the "IP Bindings" area, click the list to select the host IP address "192.168.1.61", 

and then click the "Add" button, as shown in the following figure. 



 

 

 

4 In the "Command channel port" text box under the "Reverse RealCom parameter" 

area, enter the host command port 34000; In the Data channel port text box, enter 

the host data port 33000. 

5 In the blank space of "Device List View" on the left, right-click and select "Create 

serial port quickly". 

6 In the "Create serial port quickly" window, create COM2, and the configuration is 

shown in the following figure. 



 

 

 

- Check the "Select device" radio box. 

- Click the "Search device" button to search the serial port server. 

- Check the check box under "Index" in the corresponding serial server entry. 

- Click the "Enter device information" radio box. 

- Click the "Reverse RealCom" tab and enter the MAC address, starting serial 

port number and serial port number of the device. 

- Click “OK” button. 

- In the Confirm window, click the Yes button, as shown in the following figure. 

 

7 Double-click the created COM2, enter the COM2 property page, and then click the 

"Base" tab. In the "Serial Port Properties" area, configure the serial port COM2 

parameters to be consistent with COM1 communication parameters, as shown in 

the following figure. 



 

 

 

Step 4 Run "ComTest" software to test the communication between terminal COM1 and 

management terminal COM2. 

1 Install and run "ComTest" software on the host, click "Begin" in the menu bar and 

select "New Windows". 

2 Add the real serial "COM1" and virtual serial "COM2" two windows, the "COM1" 

and "COM2" serial port parameter information match. 

 

3 Turn on the serial signals of "COM1" and "COM2" respectively, and click the 

"Manual send" button to test and check the data receiving and sending status 

between the real serial port COM1 and the virtual serial port COM2. 



 

 

 

 

Note: 

You can simulate dynamic IP by manually modifying the static IP address of the device, 

and then view the data communication between COM1 and COM2. 

Step 5 End. 



 

 

10.3 TCP Server Mode 

Background Introduction 

Assuming that the serial port "COM1" of the serial server is operating in the "TCP server 

mode", passively waiting for one host PC to connect, and the host can read or send 

Ethernet data to a serial device. 

The parameters of the serial server (TCP server) are as follows: 

 IP Address: 192.168.1.250 

 Local Port: 30000 

 Baud rate: 115200 

 Parity bit: None 

 Data bit: 8 

 Stop bit: 1 

Host PC (TCP client mode) parameter information as follow: 

 IP address: 192.168.1.61 

Operation Steps 

Step 1 Configure the IP address of the serial server. 

1. Log in to the Web configuration interface and select "Network Configuration”. 

 

2. In the "LAN1" option box, enter the “LAN1 IP configuration”, "LAN1 IP address", 

"LAN1 Subnet Mask" and "LAN1 Gateway" corresponding to the serial server. 



 

 

3. Other parameters remain the default, click "Submit". 

Step 2 Configure the serial port parameter information. 

1. Log in to the Web configuration interface and select "Communication Parameters". 

2. In the serial port 1 entry, click "Edit". 

 

3. Set the “Baud Rate”, “Data Bits”, “Stop Bits” and “Parity” in the “COM Settings” 

option box. 



 

 

 

4. Other parameters remain the default, click "Submit". 

Step 3 Configure the working mode of the serial server. 

1. Log in to the Web configuration interface and select " Operation Modes > Port1". 



 

 

 

2. Click the "Operation Mode" drop-down list box and select "TCP Server Mode". 

3. Click “Max connection” drop-down list box, and select “1 “. 

4. Enter "30000" in the "Local Port" text box. 

5. Other parameters remain the default, click "Submit". 

Step 4 Run the debug assistant software to create a TCP client for the host. 

1. Install and run debug assistant, click “create connection” drop-down list, and select 

“create network debugging” > “TcpClient”. 



 

 

 

2. In the "Local IP" drop-down list box, select the IP address "192.168.1.61" of the host 

PC (that is, the TCP client). 

3. In the "Device IP" text box, enter the IP address "192.168.1.250" of the serial server 

(that is, the TCP server). 

4. In the “Device Working Port” text box, enter the local port "30000" of the serial server 

(that is, the TCP server), and click “YES”. 

 

5. Choose the created Tcpclient connection, click "Start". 

 

Step 5 Run "ComTest" and "DebugTool" software synchronously to test the communication 

between serial port server (TCP server) and host PC (TCP client). 



 

 

 

1. Install and run the ComTest, and click “Begin > New Windows” in the start menu. 

2. Add serial port "COM1" window, and configure serial port number, baud rate, parity 

and data bit and other parameters consistent with "Communication Parameters" of 

WEB interface. 

3. Open the serial port signal of "COM1", for example, enter the serial port information 

"0123456789AB", and click "Manual send". 

4. Run the debug assistant software and view the serial port information received by the 

host PC in the TcpClient option box. Similarly, the host PC can also send messages to 

serial port devices. 

 



 

 

10.4 TCP Client Mode 

Background Introduction 

Assuming that the serial port "COM1" of the serial server is working in "TCP client 

mode", it initiates a connection with a host PC, and the host can read or send Ethernet 

data to a serial device. 

When the data transfer is completed, the serial server will automatically shut down the 

network connection after 30 seconds. 

The parameters of the serial server (TCP client) are as follows: 

 IP Address: 192.168.1.250 

 Local Port: 30000 

 Baud rate: 115200 

 Parity bit: None 

 Data bit: 8 

 Stop bit: 1 

Host PC (TCP server mode) parameter information as follow: 

 IP address: 192.168.1.61 

 Local Port:31000 

Operation Steps 

Step 1 Configure the IP address of the serial server. 

1. Log in to the Web configuration interface and select "Network Configuration”. 

 



 

 

2. In the "LAN1" option box, enter the “LAN1 IP configuration”, "LAN1 IP address", 

"LAN1 Subnet Mask" and "LAN1 Gateway" corresponding to the serial server. 

3. Other parameters remain the default, click "Submit". 

Step 2 Configure the serial port parameter information. 

1. Log in to the Web configuration interface and select "Communication Parameters". 

2. In the serial port 1 entry, click "Edit". 

 

3. Set the “Baud Rate”, “Data Bits”, “Stop Bits” and “Parity” in the “COM Settings” 

option box. 



 

 

 

4. Other parameters remain the default, click "Submit". 

Step 3 Configure the working mode of the serial server. 

1. Log in to the Web configuration interface and select "Operation Modes > Port1". 

2. Click the "Operation Mode" drop-down list box and select "TCP Client Mode". 

3. Click “Max connection” drop-down list box, and select “1” to establish one session 

connection. 

4. In the “Format” drop-down list, select “IP”. 

5. Enter the host PC's IP address "192.168.1.61" in the destination address text box. 

6. Enter the host PC's local port number, 31000, in the destination port text box. 

7. In the “Port bind” drop-down list, select “Enable”. 

8. Enter the local port number "30000" of the serial server in the "Local port" text box. 

9. Enter "30" in the "TCP alive check time" and "Inactivity Time" text boxes. 

10. Other parameters remain the default, click "Submit". 



 

 

 

Step 4 Run the debug assistant software to create a TCP server for the host. 

1. Install and run “DebugTool” software, click “create connection” drop-down list, and 

select “Create network debugging > TcpServer”. 

 

2. In the “Monitoring IP” drop-down list box, select the IP address "192.168.1.61" of the 

host PC (that is, the TCP server). 

3. In the "Local Port" text box, enter the local port "31000" of the host PC (that is, the 

TCP server) and click "OK". 



 

 

 

4. Choose the created TcpServer connection, click "Start". 

 

Step 5 Simultaneously run "ComTest" and "DebugTool" software, test the communication 

between serial server (TCP client) and the host PC (TCP server). 

1. Install and run the ComTest, and click “Begin > New Windows” in the start menu. 



 

 

 

2. Add serial port "COM1" window, and configure serial port number, baud rate, parity 

and data bit and other parameters consistent with "Communication Parameters" of 

WEB interface. 

3. Open the serial port signal of "COM1", for example, enter the serial port information 

"0123456789AB", and click "Manual send". 

4. Run the "DebugTool" software, in the TcpServer option box to check the serial 

information received by the host PC. Similarly, the host PC can also send messages to 

serial port devices. 

 



 

 

10.5 UDP Server Mode 

Background Introduction 

Assuming that the serial port "COM1" of the serial server is operating under "UDP server 

mode", passively waiting for one host PC to connect, and the host can read or send 

Ethernet data to a serial device. Compared with TCP mode, UDP protocol is faster and 

more efficient. 

The parameters of the serial server (UDP server) are as follows: 

 IP Address: 192.168.1.250 

 Local Port: 30000 

 Baud rate: 115200 

 Parity bit: None 

 Data bit: 8 

 Stop bit: 1 

Host PC (UDP client mode) parameter information as follow: 

 IP address: 192.168.1.61 

 Local Port:31000 

Operation Steps 

Step 1 Configure the IP address of the serial server. 

1. Log in to the Web configuration interface and select "Network Configuration”. 

 



 

 

2. In the "LAN1" option box, enter the “LAN1 IP configuration”, "LAN1 IP address", 

"LAN1 Subnet Mask" and "LAN1 Gateway" corresponding to the serial server. 

3. Other parameters remain the default, click "Submit". 

Step 2 Configure the serial port parameter information. 

1. Log in to the Web configuration interface and select "Communication Parameters". 

2. In the serial port 1 entry, click "Edit". 

 

3. Set the “Baud Rate”, “Data Bits”, “Stop Bits” and “Parity” in the “COM Settings” 

option box. 



 

 

 

4. Other parameters remain the default, click "Submit". 

Step 3 Configure the working mode of the serial server. 

1. Log in to the Web configuration interface and select "Operation Modes > Port1". 

2. Click the “Operation Mode” drop-down list box and select “UDP Server Mode”. 

3. Click the "Max connection" drop-down list box and select "1". 

4. Enter "30000" in the "Listen port" text box. 

5. Other parameters remain the default, click "submit". 



 

 

 

Step 4 Run the "DebugTool" software, create UDP client for the host. 

1. To install and run "DebugTool" Software, click “Create Connection” drop-down list 

box and choose “Create Network Debugging> UDP Client”. 

 

2. In the "Local IP" drop-down list box, select the IP address "192.168.1.61" of the host 

PC (that is, the Udp client). 

3. Enter the port number "31000" for the host PC (that is, the Udp client) in the "Local 

Port" text box. 



 

 

 

4. Enter the IP address "192.168.1.250" of the serial server (that is, the Udp server) in 

the "Remote IP" text box. 

5. In the “Remote Port” text box, enter the port number “30000” for the serial server 

(that is, the Udp server), and click “Yes”. 

6. Choose the created UdpClient connection, click "Start". 

 

Step 5 Simultaneous operation of the "DebugTool" and "ComTest" software, test the serial 

server (UDP server) and the host PC (UDP client) to communicate with each other. 

1. Install and run the ComTest, and click “Begin > New Windows” in the start menu. 

2. Add serial port "COM1" window, and configure serial port number, baud rate, parity 

and data bit and other parameters consistent with "Communication Parameters" of 

WEB interface. 

3. Open the serial port signal of "COM1", for example, enter the serial port information 

"0123456789AB", and click "Manual send". 



 

 

 

4. Run the debug assistant software and check the serial port information received by 

the host PC. Similarly, the host PC can also send messages to serial port devices. 

 

10.6 UDP Client Mode 



 

 

Background Introduction 

Assuming that the serial port "COM1" of the serial server works in the "UDP client 

mode", it initiates a connection with a host PC, and the host can read or send Ethernet 

data to a serial device. Compared with TCP mode, UDP protocol is faster and more 

efficient. 

The parameters of the serial server (UDP client) are as follows: 

 IP Address: 192.168.1.250 

 Local Port: 30000 

 Baud rate: 115200 

 Parity bit: None 

 Data bit: 8 

 Stop bit: 1 

Host PC (UDP server mode) parameter information as follow: 

 IP address: 192.168.1.61 

 Local Port:31000 

Operation Steps 

Step 1 Configure the IP address of the serial server. 

1. Log in to the Web configuration interface and select "Network Configuration”. 

 

2. In the "LAN1" option box, enter the “LAN1 IP configuration”, "LAN1 IP address", 

"LAN1 Subnet Mask" and "LAN1 Gateway" corresponding to the serial server. 



 

 

3. Other parameters remain the default, click "Submit". 

Step 2 Configure the serial port parameter information. 

1. Log in to the Web configuration interface and select "Communication Parameters". 

2. In the serial port 1 entry, click "Edit". 

 

3. Set the “Baud Rate”, “Data Bits”, “Stop Bits” and “Parity” in the “COM Settings” 

option box. 



 

 

 

4. Other parameters remain the default, click "Submit". 

Step 3 Configure the working mode of the serial server. 

1. Log in to the Web configuration interface and select "Operation Modes > Port1". 

2. Click the “Operation Mode” drop-down list box and select “Udp Client Mode”. 

3. Click “Max connection” drop-down list box, and select “1” to establish one session 

connection. 

4. Enter the host PC's IP address "192.168.1.61" in the destination address text box. 

5. Enter the host PC's local port number, 31000, in the destination port text box. 

6. Other parameters remain the default, click "Submit". 



 

 

 

Step 4 Run the “DebugTool” software to create a UDP server for the host. 

1. Install and run “DebugTool” software, click “create connection” drop-down list, and 

select “Create Network Debug > UDPServer”. 

 

2. In the “Monitoring IP” drop-down list box, select the IP address "192.168.1.61" of the 

host PC (that is, the UDP server). 

3. In the “Local Port” text box, enter the local port "31000" for the host PC (that is, the 

UDP server) and click “OK”. 



 

 

 

4. Choose the created UdpServer connection, click "Start". 

 

Step 5 Simultaneously run "ComTest" and "DebugTool" software, test the communication 

between serial server (UDP client) and the host PC (UDP server). 

1. Install and run the ComTest, and click “Begin > New Windows” in the start menu. 

2. Add serial port "COM1" window, and configure serial port number, baud rate, parity 

and data bit and other parameters consistent with "Communication Parameters" of 

WEB interface. 

3. Open the serial port signal of "COM1", for example, enter the serial port information 

"0123456789AB", and click "Manual send". 



 

 

 

4. Run the “DebugTool” software and view the serial port information received by the 

host PC in the UdpServer option box. Similarly, the host PC can also send messages to 

serial port devices. 

 

10.7 UDP Rang Mode 

Background Introduction 

When the router, switch and other devices do not support multicast function, the serial 

device server can work in the UDP Rang mode to achieve multicast function. Assuming 



 

 

that the serial port COM1 of the serial device server is connected to the host computer, 

it needs to transmit the serial data to two hosts that specify the same network segment 

"192.168.1.61" to "192.168.1.62" through the UDP protocol at the same time. 

The parameters of the serial server (UDP server) are as follows: 

 IP Address: 192.168.1.250 

 Local Port: 30000 

 Baud rate: 115200 

 Parity bit: None 

 Data bit: 8 

 Stop bit: 1 

Host A (UDP client A) parameter information as follow: 

 IP address: 192.168.1.61 

 Local Port:31000 

Host B (UDP client B) parameter information as follow: 

 IP address: 192.168.1.62 

 Local Port:31000 

Operation Steps 

Step 1 Configure the IP address of the serial server. 

1. Log in to the Web configuration interface and select "Network Configuration”. 

 

2. In the "LAN1" option box, enter the “LAN1 IP configuration”, "LAN1 IP address", 

"LAN1 Subnet Mask" and "LAN1 Gateway" corresponding to the serial server. 



 

 

3. Other parameters remain the default, click "Submit". 

Step 2 Configure the serial port parameter information. 

1. Log in to the Web configuration interface and select "Communication Parameters". 

2. In the serial port 1 entry, click "Edit". 

 

3. Set the “Baud Rate”, “Data Bits”, “Stop Bits” and “Parity Bits” in the “COM Settings” 

option box. 

 



 

 

4. Other parameters remain the default, click "Submit". 

Step 3 Configure the working mode of the serial server. 

1. Log in to the Web configuration interface and select " Operation Modes > Port1". 

 

2. Click the “Operation Mode” drop-down list box and select “UDP Rang Mode”. 

3. Click “Max connection” drop-down list box, and select “1 “. 

4. In the "Start Address" and "End Address" text boxes, enter the IP address 

"192.168.1.61" of Host A and the IP address "192.168.1.62" of Host B, respectively. 

5. Enter the port number "31000" of the host in the "Destination Port" text box. 

6. Enter the port number "30000" of the serial device server in the "Local listen port" 

text box. 

7. Other parameters remain the default, click "Submit". 

Step 4 Run the debug assistant software on host A to create Udp client A. 

1. To install and run "Debug Tool" Software, click “Create Connection” drop-down list 

box and choose “Create Network Debugging> UDP Client”. 



 

 

 

2. In the “Local IP” drop-down list box, select the IP address "192.168.1.61" of the host A 

(that is, the UDP client A). 

3. In the “Local Port” text box, enter the local port "31000" for the host A (that is, the 

UDP client A). 

4. Enter the IP address "192.168.1.250" of the serial server (that is, the Udp server) in 

the "Remote IP" text box. 

5. In the “Remote Port” text box, enter the port number “30000” for the serial server 

(that is, the Udp server), and click “OK”. 

 

6. Choose the created UdpClient connection, click "Start". 

 



 

 

Step 5 Run the debug assistant software on host B to create Udp client B. 

1. To install and run "Debug Tool" Software, click “Create Connection” drop-down list 

box and choose “Create Network Debugging> UDP Client”. 

 

2. On the pop-up "Local IP" drop-down list box, choose the IP address of host B (Udp 

client B) "192.168.1.62". 

3. In the “Local Port” text box, enter the local port "31000" for the host A (that is, the 

UDP client A). 

4. Enter the IP address "192.168.1.250" of the serial server (that is, the Udp server) in 

the "Remote IP" text box. 

5. In the “Remote Port” text box, enter the port number “30000” for the serial server 

(that is, the Udp server), and click “OK”. 

 

6. Choose the created UdpClient connection, click "Start". 



 

 

 

Step 6 Simultaneous operation of the "DebugTool" and "ComTest" software, test the serial 

server, host A and host B to communicate with each other. 

1. Install and run the ComTest, and click “Begin > New Windows” in the start menu. 

2. Add serial port "COM1" window, and configure serial port number, baud rate, parity 

and data bit and other parameters consistent with "Communication Parameters" of 

WEB interface. 

3. Open the serial port signal of "COM1", for example, enter the serial port information 

"0123456789AB", and click "Manual send". 

4. Run the Debug Assistant and check the serial port information received by host A and 

host B in the UdpClient option box. Similarly, host A and host B can also send 

information to the serial device. 

 



 

 

 

 

10.8 UDP Multicast Mode 

Background Introduction 

It's assumed that serial server IP address is "192.168.1.250", user needs to add the serial 

server to the multicast address "239.0.0.0". So that the serial server through the UDP 

protocol can make the serial device data through unicast or multicast sent to one or 

more hosts, but also can receive from one or more host unicast or multicast data, 

complete multipoint-to-multipoint communication. 

The parameters of the serial server are as follows: 

 IP Address: 192.168.1.250 

 Local Port: 30000 

 Baud rate: 115200 



 

 

 Parity bit: None 

 Data bit: 8 

 Stop bit: 1 

Host PC parameter information as follow: 

 IP address: 192.168.1.61 

 Local Port:31000 

Operation Steps 

Step 1 Configure the IP address of the serial server. 

1. Log in to the Web configuration interface and select "Network Configuration”. 

 

2. In the "LAN1" option box, enter the “LAN1 IP configuration”, "LAN1 IP address", 

"LAN1 Subnet Mask" and "LAN1 Gateway " corresponding to the serial server. 

3. Other parameters remain the default, click "Submit". 

Step 2 Configure the serial port parameter information. 

1. Log in to the Web configuration interface and select "Communication Parameters". 

2. In the serial port 1 entry, click "Edit". 



 

 

 

3. Set the “Baud Rate”, “Data Bits”, “Stop Bits” and “Parity” in the “COM Settings” 

option box. 

 

4. Other parameters remain the default, click "Submit". 



 

 

Step 3 Configure the working mode of the serial server. 

1. Log in to the Web configuration interface and select "Operation Modes > Port1". 

2. Click the “Operation Mode” drop-down list box and select “UDP Multicast Mode”. 

3. Click “Max connection” drop-down list box, and select “1” to establish one session 

connection. 

4. Click the “Group Number” drop-down list box and select “1”. 

5. Enter "30000" for the local port number of the serial port server in the listen port text 

box. 

6. Enter the group address "224.0.0.0" of the host PC in the "Destination Address" text 

box. 

7. Enter the host PC's local port number, 31000, in the destination port text box. 

8. Enter the group address "239.0.0.0" of the host PC in the "Multicast addr Group 1" 

text box. 

9. Other parameters remain the default, click "Submit". 

 

Step 4 Run the “DebugTool” software to create a UDP multicast server for the host. 



 

 

1. Install and run “DebugTool”, click “Create Connection” drop-down list, and select 

“Create Network Debug” > “UdpGroup”. 

 

2. In the "Local IP" drop-down list box, select the IP address "192.168.1.61" of the host. 

3. In the “Local Port” text box, enter the local port "31000" for the host. 

4. In the “Remote IP” text box, enter the IP address "239.0.0.0" for the serial device 

server. 

5. In the “Remote Port” text box, enter the local port number "30000" for the serial 

device server. 

6. In the “Multicast” text box, enter the multicast group address "224.0.0.0". 

  

7. Choose the created UdpGroup connection, click "Start". 



 

 

 

Step 5 Simultaneously run "ComTest" and "DebugTool" software, test the communication 

between serial server and the host PC. 

1. Install and run the ComTest, and click “Begin > New Windows” in the start menu. 

2. Add serial port "COM1" window, and configure serial port number, baud rate, parity 

and data bit and other parameters consistent with "Communication Parameters" of 

WEB interface. 

3. Open the serial port signal of "COM1", for example, enter the serial port information 

"0123456789AB", and click "Manual send". 

 

4. Run the “DebugTool” software to check the serial port information received by the 

host PC in the UdpGroup option box. Similarly, the host PC can also send messages to 

serial port devices. 



 

 

 

10.9 Pair Slave & Master Mode 

Background Introduction 

Pair mode requires two serial server devices to work together to break the serial data 

transmission distance limit. The two serial servers in this mode establish a network 

connection with each other via Ethernet and transparently transmit data from the 

respective serial port to each other. 

Assume that serial device server A uses pair slave mode to passively wait for a 

connection. 

The serial device server B uses the pair master mode to actively connect the serial 

device server A. 

The serial port that serial server A and serial port B connect with the computer is 

“COM1”. 

The "dest address" of the serial server B is the IP address "192.168.1.254" of the serial 

server A. The “dest port” of the serial server B is the listening port "30000" of the serial 

server A. 

Serial device server A configuration steps 

Step 1 Log in to the Web configuration interface and select "Operation Modes > Port1". 

Step 2 Click the “Operation Mode” drop-down list box and select “Pair Slave Mode”. 



 

 

  

Step 3 Enter "30000" in the "Local Port" text box. 

Step 4 Other parameters remain the default, click "Submit” to finish the settings. 

Serial device server B configuration steps 

Step 1 Log in to the Web configuration interface and select "Operation Modes > Port1". 

Step 2 Click the “Operation Mode” drop-down list box and select “Pair Master Mode”. 

 

Step 3 Enter the IP address "192.168.1.254" of the serial device server A in the "Destination 

Address" text box. 



 

 

Step 4 Enter local port "30000” for serial port server A in the destination port text box. 

Step 5 Other parameters maintain the default, click "Submit". 

After the completion of the above configuration, serial server A and serial server B 

establish connection successfully, and they can send and receive serial data from each 

other. 

10.10 Telnet Mode 

Background Introduction 

The PC connects to the Port 1 of serial port server through RS-232 to access the server 

on the network. 

Assume the IP address of the serial port server is 192.168.1.250; The IP address of the 

server is 192.168.1.10. 

The serial port information is as follows: 

 Baud rate: 115200 

 Parity bit: None 

 Data bit: 8 

 Stop bit: 1 

Operation Steps 

Step 1 Configure the IP address of the serial server. 

1. Log in to the Web configuration interface and select "Network Configuration”. 

 



 

 

2. In the "LAN1" option box, enter the “LAN1 IP configuration”, "LAN1 IP address", 

"LAN1 Subnet Mask" and "LAN1 Gateway " corresponding to the serial server. 

3. Other parameters remain the default, click "Submit". 

Step 2 Configure the serial port parameter information. 

1. Log in to the Web configuration interface and select "Communication Parameters". 

2. In the serial port 1 entry, click "Edit". 

 

3. Set the “Baud Rate”, “Data Bits”, “Stop Bits” and “Parity” in the “COM Settings” 

option box. 



 

 

 

4. Other parameters remain the default, click "Submit". 

Step 3 Configure the working mode of the serial server. 

1. Log in to the Web configuration interface and select "Operation Modes > Port1". 

2. Click the Operation Mode drop-down list box and select “Telnet Mode”. 

3. Click “Max connection” drop-down list box, and select “1” to establish one session 

connection. 

4. Enter "192.168.1.10” in the host PC's IP address in the destination address text box. 

5. Enter “23” in local port number in the destination port text box. 

6. Other parameters remain the default, click "Submit". 



 

 

 

Step 4 Run the third party software PuTTY on a PC to test the communication between the host 

PC and the server. 

1. Install and run the PuTTY software. 

 

2. Click "Session" and select "serial" serial port communication in the input field of 

"Connection type"; 

3. In the "Serial line" text box, enter the local serial port number for PC to connect with 

serial port server; 



 

 

4. Enter “115200” baud rate in the "Speed" text box; 

5. Click “Open” button to open the COM session interface and start accessing the server. 

 

10.11 Reverse Telnet Mode 

Background Introduction 

The PC connects to the serial port server through Ethernet to access the server device or 

Console port connected under the serial port. 

Assume the IP address of the serial port server is 192.168.1.250. 

The serial port information is as follows: 

 Baud rate: 115200 

 Parity bit: None 

 Data bit: 8 

 Stop bit: 1 

Operation Steps 

Step 1 Configure the IP address of the serial server. 

1. Log in to the Web configuration interface and select "Network Configuration”. 



 

 

 

2. In the "LAN1" option box, enter the “LAN1 IP configuration”, " LAN1 IP address", " 

LAN1 Subnet Mask" and " LAN1 Gateway" corresponding to the serial server. 

3. Other parameters remain the default, click "Submit". 

Step 2 Configure the serial port parameter information. 

1. Log in to the Web configuration interface and select "Communication Parameters". 

2. In the serial port 1 entry, click "Edit". 

 



 

 

3. Set the “Baud Rate”, “Data Bits”, “Stop Bits” and “Parity” in the “COM Settings” 

option box. 

 

4. Other parameters remain the default, click "Submit". 

Step 3 Configure the working mode of the serial server. 

1. Log in to the Web configuration interface and select "Operation Modes > Port1". 

2. Click the operation mode drop-down list box and select “Reverse Telnet Mode”. 

3. Click “Max connection” drop-down list box, and select “1” to establish one session 

connection. 

4. Enter the local port number "30000" in the listening port text box. 

5. Other parameters remain the default, click "Submit". 



 

 

 

Step 4 Run the third party software PuTTY on a PC to test the communication between the host 

PC and the server. 

1. Install and run the PuTTY software. 

 

2. Click “Session” and select “Telnet” protocol communication in the Connection type 

input field. 

3. Enter the IP address "192.168.1.250" of the serial port server in the "Host Name" text 

box. 



 

 

4. Enter the serial Port server listening Port number "30000" in the "Port" text box. 

5. Click “Open” button to open the Telnet session interface and start accessing the 

server. 

 

10.12 RFC2217 Mode 

Background Introduction 

The PC connects the serial port server link port through Ethernet, and maps the serial 

port Port1 to the local COM2 port on the PC. Meanwhile, the real serial port COM1 of PC 

is connected with the serial port server Port1. 

Assume the IP address of the serial port server is 192.168.1.250. 

The serial port information is as follows: 

 Baud rate: 115200 

 Parity bit: None 

 Data bit: 8 

 Stop bit: 1 

Operation Steps 

Step 1 Configure the IP address of the serial server. 

1. Log in to the Web configuration interface and select "Network Configuration”. 



 

 

 

2. In the "LAN1" option box, enter the “LAN1 IP configuration”, "LAN1 IP address", 

"LAN1 Subnet Mask" and "LAN1 Gateway" corresponding to the serial server. 

3. Other parameters remain the default, click "Submit". 

Step 2 Configure the serial port parameter information. 

1. Log in to the Web configuration interface and select "Communication Parameters". 

2. In the serial port 1 entry, click "Edit". 

 



 

 

3. Set the “Baud Rate”, “Data Bits”, “Stop Bits” and “Parity” in the “COM Settings” 

option box. 

 

4. Other parameters remain the default, click "Submit". 

Step 3 Configure the working mode of the serial server. 

1. Log in to the Web configuration interface and select "Operation Modes > Port1". 

2. Click the operation mode drop-down list box and select “RFC2217 Mode”. 

3. Click “Max connection” drop-down list box, and select “1” to establish one session 

connection. 

4. Enter the port number of the device "30000" in the local port text box. 

5. Other parameters remain the default, click "Submit". 



 

 

  

Step 4 Run the third-party software "Serial Port Redirector" on the PC, which is a virtual COM 

Port. 

1. Install and run the "Serial Port Redirector" software. 

2. Click to add serial port icon “ ” 

 

3. In the "virtual serial port" drop-down list, select the COM port that needs to be 

virtual. 



 

 

 

4. Click the Advanced button, select Telnet (RFC2217) in the Protocol configuration 

option, and click “OK”. 

 

5. Enter the IP address "192.168.1.250" of the serial port server in the "Host Name" text 

box. 

6. Enter "30000" for the local port of serial port server in the "TCP-port" text box. 

7. Click “OK”. 

Step 5 Run "ComTest" on PC to test PC virtual COM2 and real serial COM1. 

1. Install and run the ComTest software, and click “Begin > New Windows” in the start 

menu. 

2. Add the real serial "COM1" and virtual serial "COM2" two windows, the "COM1" and 

"COM2" serial port parameter information match. 



 

 

 

3. Open “COM1” and “COM2” serial signal respectively, check “automatic sending” 

checkbox, test and check the data transmission status between real serial port COM1 

and virtual serial port COM2. 

 



 

 

 

10.13 Redundant COM Mode 

Background Introduction 

Assuming that the host is in the backup network environment composed of network A 

and Network B, the host needs to manage the serial terminal device through the serial 

server. Now connect the host's own RS-232 serial port, COM1, to the Port1 of the serial 

server, and install ComTest software to simulate the serial terminal device. At the same 

time, the host computer installs VSP software, maps the serial port terminal device 

connected to the serial port server Port1 to the local COM2 of the host computer, and 

simulates the management terminal by ComTest software. When the network of the 

serial server switches, the communication between the management terminal (COM2) 

and the terminal (COM1) can still be normal. 

Parameter information of serial terminal is as follows: 

 Baud rate: 115200 

 Parity bit: None 

 Data bit: 8 

 Stop bit: 1 

Host parameter information as follow: 

 IP address of connecting network A: 192.168.1.61 

 IP address of connecting network B: 172.13.100.110 



 

 

 Data port: 33000 

 Command port: 34000 

The parameters of the serial server are as follows: 

 LAN1 IP Address: 192.168.1.250 

 LAN2 IP Address: 172.13.100.250 

 Communication parameters: Port1 is consistent with serial terminal parameters 

 Working mode: Redundant COM Mode 

Operation steps 

Step 1 Configure the IP address of the serial server, as shown in the following figure. 

 

1 Log in to the Web configuration interface and select "Network Configuration". 

2 In the LAN mode drop-down list, select Dual IP. 

3 In the LAN1 area, enter the IP address (192.168.1.250), subnet mask and gateway 

address of the serial server port LAN1. 

4 In the LAN2 area, enter the IP address (172.13.100.250), subnet mask and gateway 

address of the serial server port LAN2.  

5 Other parameters remain the default, click “Submit”. 

Step 2 Configure the communication parameter information of serial server. 

1 Log in to the WEB configuration interface and select "Communication Parameters". 



 

 

2 In the Port1 entry, click Edit under operation, as shown in the following figure. 

 

3 In the serial port parameter option box, set "Baud Rate", "Parity", "Data Bits", "Stop 

Bits" and "interface" parameters respectively, as shown in the following figure. 

 



 

 

4 Other parameters remain the default, click “Submit”. 

Step 3 Configure the working mode of the serial server, as shown in the following figure. 

 

1 Log in to the WEB configuration interface and select "Operation Modes > Port1". 

2 Click the "Operation mode" drop-down list and select "Redundant COM Mode". 

3 Other parameters remain the default, click “Submit”. 

Step 4 Run "VSP Manager" software, configure the virtual serial port COM2. 

1 Install and run the "VSP Manager" software on the host, and refer to the VSP user 

manual for the installation process. 

2 On the menu bar, click View > VSP Service Properties, and then click the Advance 

tab. 

3 In the "IP Bindings" area, click the list to select the host IP address "192.168.1.61", 

and then click the "Add" button, as shown in the following figure. 



 

 

 

4 In the blank space of "Device List View" on the left, right-click and select "Create 

serial port quickly". 

5 In the "Create serial port quickly" window, create COM2, and the configuration is 

shown in the following figure. 

 

- Check the "Select device" radio box. 

- Click the "Search device" button to search the serial port server. 



 

 

- Check the check box under "Index" in the corresponding serial server entry. 

- Click the "Enter device information" radio box. 

- Click the "Redundant COM" tab and enter the IP address 1, IP address 2 and 

serial port number of the device. 

- Click “OK” button. 

- In the Confirm window, click the Yes button, as shown in the following figure. 

 

6 Double-click the created COM2, enter the COM2 property page, and then click the 

"Base" tab. In the "Serial Port Properties" area, configure the serial port COM2 

parameters to be consistent with COM1 communication parameters, as shown in 

the following figure. 

 

Step 5 Run "ComTest" software to test the communication between terminal COM1 and 

management terminal COM2. 

1 Install and run "ComTest" software on the host, click "Begin" in the menu bar and 

select "New Windows". 

2 Add the real serial "COM1" and virtual serial "COM2" two windows, the "COM1" 

and "COM2" serial port parameter information match. 



 

 

 

3 Turn on the serial signals of "COM1" and "COM2" respectively, and click the 

"Manual send" button to test and check the data receiving and sending status 

between the real serial port COM1 and the virtual serial port COM2. 

 



 

 

 

Note: 

You can simulate network failure by manually disconnecting Network A or Network B, and 

then view the data communication between COM1 and COM2. 

Step 6 End. 

10.14 DRDAS RealCom Mode 

Background Introduction 

Assuming that Host A and Host B are in the same network environment, Host A needs to 

collect serial data and control serial terminal device in COM form through serial server; 

While Host B is only used for monitoring or backing up serial terminal device data. Now, 

another host's own RS-232 serial port, COM1, is connected to Port1 of serial server, and 

ComTest software is installed to simulate serial terminal device. At the same time, Host 

A and Host B install VSP software, and map the serial terminal device connected with 

the serial server Port1 to the local COM2 of Host A and Host B, and simulate the 

management terminal by ComTest software. 

Parameter information of serial terminal is as follows: 

 Baud rate: 115200 

 Parity bit: None 

 Data bit: 8 



 

 

 Stop bit: 1 

Host A parameter information is as follow: 

 IP address: 192.168.1.61 

Host B parameter information is as follow: 

 IP address: 192.168.1.62 

The parameters of the serial server are as follows: 

 IP address: 192.168.1.250 

 Communication parameters: Port1 is consistent with serial terminal parameters 

 Working mode: DRDAS RealCom Mode 

Operation steps 

Step 1 Configure the IP address of the serial server, as shown in the following figure. 

 

1 Log in to the Web configuration interface and select "Network Configuration". 

2 In the LAN1 area, enter the IP address (192.168.1.250), subnet mask and gateway 

address of the serial server. 

3 Other parameters remain the default, click “Submit”. 

Step 2 Configure the communication parameter information of serial server. 

1 Log in to the WEB configuration interface and select "Communication Parameters". 

2 In the Port1 entry, click Edit under operation, as shown in the following figure. 



 

 

 

3 In the serial port parameter option box, set "Baud Rate", "Parity", "Data Bits", "Stop 

Bits" and "interface" parameters respectively, as shown in the following figure. 

 

4 Other parameters remain the default, click “Submit”. 

Step 3 Configure the working mode of the serial server, as shown in the following figure. 



 

 

 

1 Log in to the WEB configuration interface and select "Operation Modes > Port1". 

2 Click the "Operation mode" drop-down list and select "DRDAS RealCom Mode". 

3 In the "Primary IP address" text box, enter the IP address of Host A "192.168.1.61". 

4 In the "Backup IP address1" text box, enter the IP address of Host B "192.168.1.62". 

5 Other parameters remain the default, click “Submit”. 

Step 4 Run "VSP Manager" software, configure the virtual serial port COM2 on Host A and Host 

B one by one. 

1 Install and run the "VSP Manager" software on the host, and refer to the VSP user 

manual for the installation process. 

2 On the menu bar, click View > VSP Service Properties, and then click the Advance 

tab. 

3 In the "IP Bindings" area, click the list to select the host IP address and then click 

the "Add" button, as shown in the following figure. (the IP of Host A is 192.168.1.61 

and the IP address of Host B is 192.168.1.62) 



 

 

 

4 In the left “Device List View” area, click the search icon to automatically search for 

devices. 

5 In the left “Device List View” area, right-click the IP address of the device and select 

“Add Port”. 

6 In the "Add Port" window, create a serial port COM2, as shown in the following 

figure. 

- Click the "Number of Ports to Add" drop-down list and select the serial port 

"1". 

- Click the "Starting COM Port" drop-down list and select "COM2". 

- Click “OK” button. 

 



 

 

7 Double-click the created COM2, enter the COM2 property page, and then click the 

"Base" tab. In the "Serial Port Properties" area, configure the serial port COM2 

parameters to be consistent with COM1 communication parameters, as shown in 

the following figure. 

 

Step 5 Run "ComTest" software to test the communication among terminal COM1, Host 

A(COM2) and Host B(COM2). 

1 Install and run "ComTest" software on each host, click "Begin" in the menu bar and 

select "New Windows". 

2 Serial port "COM1" is connected to host computer, and serial port "COM2" is 

connected to host computer and host computer b, and the serial port parameter 

information of "COM1" and "COM2" is matched consistently. 



 

 

 

3 Turn on the serial signals of "COM1" and "COM2" respectively, and click the 

"Manual send" button to test and check the data receiving and sending status 

between the real serial port COM1 and the virtual serial port COM2. 

 

Host A COM2: 



 

 

 

Host B COM2: 

 

Note: 

Through the test, it can be found that both Host A and Host B can receive the data sent by 

COM1; COM1 can receive the data sent by Host A; COM1 does not receive the data sent 

by Host B. 



 

 

Step 6 End. 

10.15 DRDAS TCP Server Mode 

Background Introduction 

Assuming that Host A and Host B are in the same network environment, Host A needs to 

collect serial data and control serial terminal device in TCP Socket form through serial 

server; While Host B is only used for monitoring or backing up serial terminal device 

data. Now, another host's own RS-232 serial port, COM1, is connected to Port1 of serial 

server, and ComTest software is installed to simulate serial terminal device. At the same 

time, Host A and Host B install DebugTool software, which is used as TCP client to 

establish connection with serial port server Port1, and the management end is simulated 

by DebugTool software. 

Parameter information of serial terminal is as follows: 

 Baud rate: 115200 

 Parity bit: None 

 Data bit: 8 

 Stop bit: 1 

Host A parameter information is as follow: 

 IP address: 192.168.1.61 

Host B parameter information is as follow: 

 IP address: 192.168.1.62 

The parameters of the serial server are as follows: 

 IP address: 192.168.1.250 

 Local Port: 30000 

 Communication parameters: Port1 is consistent with serial terminal parameters 

 Working mode: DRDAS TCP Server Mode 

Operation steps 

Step 1 Configure the IP address of the serial server, as shown in the following figure. 



 

 

 

1 Log in to the Web configuration interface and select "Network Configuration". 

2 In the LAN1 area, enter the IP address (192.168.1.250), subnet mask and gateway 

address of the serial server. 

3 Other parameters remain the default, click “Submit”. 

Step 2 Configure the communication parameter information of serial server. 

1 Log in to the WEB configuration interface and select "Communication Parameters". 

2 In the Port1 entry, click Edit under operation, as shown in the following figure. 

 

3 In the serial port parameter option box, set "Baud Rate", "Parity", "Data Bits", "Stop 

Bits" and "interface" parameters respectively, as shown in the following figure. 



 

 

 

4 Other parameters remain the default, click “Submit”. 

Step 3 Configure the working mode of the serial server, as shown in the following figure. 

 



 

 

1 Log in to the WEB configuration interface and select "Operation Modes > Port1". 

2 Click the "Operation mode" drop-down list and select "DRDAS TCP Server Mode". 

3 In the "Primary IP address" text box, enter the IP address of Host A "192.168.1.61". 

4 In the "Backup IP address1" text box, enter the IP address of Host B "192.168.1.62". 

5 Enter "30000" for the local port of serial port server in the "Local Port" text box. 

6 Other parameters remain the default, click “Submit”. 

Step 4 Run the "DebugTool" software and configure TCP clients on Host A and Host B in turn. 

1 Install and run the "DebugTool" software on the host. 

2 On the toolbar, click the “Create connection” drop-down list, and then select 

“Create network debugging > TCPclient”, as shown in the following figure. 

 

3 On the "Client parameter" serial port, configure TCP connection parameters, as 

shown in the following figure. 

 

- Click the “Local IP” drop-down list and select the IP address of the binding 

host. (the IP of Host A is 192.168.1.61 and the IP address of Host B is 

192.168.1.62) 

- In the “Remote IP” text box, enter the IP address "192.168.1.250" for the 

serial server. 

- In the "Device working port" text box, enter the serial port number "30000". 



 

 

- Click the "Yes" button. 

4 Click to select the established TCP client, and then click the "Start" button, as shown 

in the following figure. 

 

Step 5 Run "ComTest" software and "DebugTool" software to test the communication among 

terminal COM1, Host A (TCP Client) and Host B (TCP Client). 

1 Install and run "ComTest" software on the host, click "Begin" in the menu bar and 

select "New Windows". 

2 Connect the serial port "COM1" on the host, and match the serial port parameter 

information of "COM1" and the serial server Port1. 

3 Turn on the serial signal of "COM1", click the "Manual send" button, and test and 

check the data receiving and sending status of real serial port COM1, Host A and 

Host B. 

 



 

 

Host A (TCP Client): 

 

Host B (TCP Client): 

 

Note: 

Through the test, it can be found that both Host A and Host B can receive the data sent by 

COM1; COM1 can receive the data sent by Host A; COM1 does not receive the data sent 

by Host B. 

Step 6 End. 


